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Getting Started

The following sections use examples to give you a quick introduction to using Simulink® to model and
simulate dynamic systems.

What Is Simulink? (p. 1-2) Introduces Simulink.
Running a Demo Model (p. 1-4) Example of how to run a Simulink model.
Building a Model (p. 1-9) Example of how to build a Simulink model.

Setting Simulink Preferences (p. 1-18) How to set Simulink preferences.



1 Geii ng Started

What Is Simulink?

1-2

Simulink is a software package for modeling, simulating, and analyzing
dynamic systems. It supports linear and nonlinear systems, modeled in
continuous time, sampled time, or a hybrid of the two. Systems can also be
multirate, i.e., have different parts that are sampled or updated at different
rates.

Tool for Simulation

Simulink encourages you to try things out. You can easily build models from
scratch, or take an existing model and add to it. You have instant access to all
the analysis tools in MATLAB 7, so you can take the results and analyze and
visualize them. A goal of Simulink is to give you a sense of the fun of modeling
and simulation, through an environment that encourages you to pose a
question, model it, and see what happens.

Simulink is also practical. With thousands of engineers around the world using
it to model and solve real problems, knowledge of this tool will serve you well
throughout your professional career.

Tool for Model-Based Design

With Simulink, you can move beyond idealized linear models to explore more
realistic nonlinear models, factoring in friction, air resistance, gear slippage,
hard stops, and the other things that describe real-world phenomena. Simulink
turns your computer into a lab for modeling and analyzing systems that simply
wouldn’t be possible or practical otherwise, whether the behavior of an
automotive clutch system, the flutter of an airplane wing, the dynamics of a
predator-prey model, or the effect of the monetary supply on the economy.

For modeling, Simulink provides a graphical user interface (GUI) for building
models as block diagrams, using click-and-drag mouse operations. With this
interface, you can draw the models just as you would with pencil and paper (or
as most textbooks depict them). This is a far cry from previous simulation
packages that require you to formulate differential equations and difference
equations in a language or program. Simulink includes a comprehensive block
library of sinks, sources, linear and nonlinear components, and connectors. You
can also customize and create your own blocks. For information on creating
your own blocks, see the Writing S-Functions documentation.



What Is Simulink?

Models are hierarchical, so you can build models using both top-down and
bottom-up approaches. You can view the system at a high level, then
double-click blocks to go down through the levels to see increasing levels of
model detail. This approach provides insight into how a model is organized and
how its parts interact.

After you define a model, you can simulate it, using a choice of integration
methods, either from the Simulink menus or by entering commands in the
MATLAB Command Window. The menus are particularly convenient for
interactive work, while the command-line approach is very useful for running
a batch of simulations (for example, if you are doing Monte Carlo simulations
or want to sweep a parameter across a range of values). Using scopes and other
display blocks, you can see the simulation results while the simulation is
running. In addition, you can change many parameters and see what happens
for “what if” exploration. The simulation results can be put in the MATLAB
workspace for postprocessing and visualization.

Model analysis tools include linearization and trimming tools, which can be
accessed from the MATLAB command line, plus the many tools in MATLAB
and its application toolboxes. And because MATLAB and Simulink are
integrated, you can simulate, analyze, and revise your models in either
environment at any point.

Related Products

The MathWorks provides several products that are especially relevant to the
kinds of tasks you can perform with Simulink and that extend the capabilities
of Simulink. For information about these related products, see
http://www.mathworks.com/products/simulink/related.html.
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Running a Demo Model

An interesting demo program provided with Simulink models the
thermodynamics of a house. To run this demo, follow these steps:

1 Start MATLAB. See your MATLAB documentation if you’re not sure how to
do this.

2 Run the demo model by typing thermo in the MATLAB Command Window.
This command starts up Simulink and creates a model window that contains
this model.

=10l x|
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3 Double-click the Scope block labeled Thermo Plots.

The Scope block displays two plots labeled Indoor vs. Outdoor Temp and
Heat Cost ($), respectively.
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Running a Demo Model

4 To start the simulation, pull down the Simulation menu and choose the
Start command (or, on Microsoft Windows, click the Start button on the
Simulink toolbar). As the simulation runs, the indoor and outdoor
temperatures appear in the Indoor vs. Outdoor Temp plot and the
cumulative heating cost appears in the Heat Cost ($) plot.

5 To stop the simulation, choose the Stop command from the Simulation
menu (or click the Pause button on the toolbar). If you want to explore other
parts of the model, look over the suggestions in “Some Things to Try” on
page 1-6.

6 When you're finished running the simulation, close the model by choosing
Close from the File menu.

Description of the Demo

The demo models the thermodynamics of a house. The thermostat is set to 70
degrees Fahrenheit and is affected by the outside temperature, which varies by
applying a sine wave with amplitude of 15 degrees to a base temperature of 50
degrees. This simulates daily temperature fluctuations.

The model uses subsystems to simplify the model diagram and create reusable
systems. A subsystem is a group of blocks that is represented by a Subsystem
block. This model contains five subsystems: one named Thermostat, one named
House, and three Temp Convert subsystems (two convert Fahrenheit to
Celsius, one converts Celsius to Fahrenheit).

The internal and external temperatures are fed into the House subsystem,
which updates the internal temperature. Double-click the House block to see
the underlying blocks in that subsystem.

Indoor Temp
Tin

House subsystem

Themodynamic ode|

1/Req
forthe Houss

Cutdoor Temp
Tout
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The Thermostat subsystem models the operation of a thermostat, determining
when the heating system is turned on and off. Double-click the block to see the
underlying blocks in that subsystem.

O, () Thermostat subsystem
Temr Blaower

Relay1

awitch

Both the outside and inside temperatures are converted from Fahrenheit to
Celsius by identical subsystems.

"
Faheit b (") Fahrenheit to Celsius conversion (F2()

Celsius
out

When the heat is on, the heating costs are computed and displayed on the Heat
Cost ($) plot on the Thermo Plots Scope. The internal temperature is displayed
on the Indoor Temp Scope.

Some Things to Try

Here are several things to try to see how the model responds to different
parameters:

¢ Each Scope block contains one or more signal display areas and controls that
enable you to select the range of the signal displayed, zoom in on a portion of
the signal, and perform other useful tasks. The horizontal axis represents
time and the vertical axis represents the signal value.

¢ The Constant block labeled Set Point (at the top left of the model) sets the
desired internal temperature. Open this block and reset the value to 80
degrees. Rerun the simulation to see how the indoor temperature and
heating costs change. Also, adjust the outside temperature (the Avg Outdoor
Temp block) and rerun the simulation to see how it affects the indoor
temperature.

® Adjust the daily temperature variation by opening the Sine Wave block
labeled Daily Temp Variation and changing the Amplitude parameter and
rerun the simulation.
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What This Demo lllustrates
This demo illustrates several tasks commonly used when you are building
models:

¢ Running the simulation involves specifying parameters and starting the
simulation with the Start command, described in “Diagnosing Simulation
Errors” on page 10-89.

® You can encapsulate complex groups of related blocks in a single block, called
a subsystem. See “Creating Subsystems” on page 4-21 for more information.

® You can customize the appearance of and design a dialog box for a block by
using the masking feature, described in detail in Chapter 12, “Creating
Masked Subsystems.” The thermo model uses the masking feature to
customize the appearance of all the Subsystem blocks that it contains.

® Scope blocks display graphic output much as an actual oscilloscope does.

Other Useful Demos

Other demos illustrate useful modeling concepts. You can access these demos
from the MATLAB Command Window:

1 Click the Start button on the bottom left corner of the MATLAB Command
Window.

The Start menu appears.

<) MATLAB =lol x|
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2 Select Demos from the menu.

The MATLAB Help browser appears with the Demos pane selected.

File Edit Yiew Go Web ‘Window Help
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+-(] Features

(- General physical and mathernatical systems, including those with

---[“_‘| Autornotive nonlinear elements and those that make use of continuous

-] Aerospace - and discrete time. =l

3 Click the Simulink entry in the Demos pane.

The entry expands to show groups of Simulink demos. Use the browser to
navigate to demos of interest. The browser displays explanations of each demo
and includes a link to the demo itself. Click on a demo link to start the demo.



Building a Model

Building a Model

This example shows you how to build a model using many of the model-building
commands and actions you will use to build your own models. The instructions
for building this model in this section are brief. All the tasks are described in

more detail in the next chapter.

The model integrates a sine wave and displays the result along with the sine
wave. The block diagram of the model looks like this.

Seope

Integrtor

To create the model, first enter simulink in the MATLAB Command Window.
On Microsoft Windows, the Simulink Library Browser appears.
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On UNIX, the Simulink library window appears.

lLibrary: simulink 10l =|

File Edit WYiew Formatb Help
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To create a new model on UNIX, select Model from the New submenu of the
Simulink library window’s File menu. To create a new model on Windows, click
the New Model button on the Library Browser’s toolbar.

[ simulink Library Browser 101 =l
File Edit Wiew Help

New model button v = 1 44 I

Commonly Used Blocks: simulink/Commonly
Uszed Blocks

=1 W] Simulink
e B Commanly Used Blocks

Simulink opens a new model window.
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Building a Model

To create this model, you need to copy blocks into the model from the following
Simulink block libraries:

® Sources library (the Sine Wave block)

¢ Sinks library (the Scope block)

® Continuous library (the Integrator block)

¢ Signal Routing library (the Mux block)

You can copy a Sine Wave block from the Sources library, using the Library
Browser (Windows only) or the Sources library window (UNIX and Windows).

To copy the Sine Wave block from the Library Browser, first expand the
Library Browser tree to display the blocks in the Sources library. Do this by
clicking the Sources node to display the Sources library blocks. Finally, click
the Sine Wave node to select the Sine Wave block.

Here is how the Library Browser should look after you have done this.

[FAsimulink Library Browser o ] 5

File Edit WYiew Help

DS =

Sine Wave: Output a sine wave: ﬂ

0[t] = &mp*Sin[2°piFreqt+Phaze] + Bias

Sine type determines the computational technique used. The parameters in the two types are related LI

Harew ik o .
588 muink € A e s —H— Simulink library

----- 2] Commonly Used Blocks
..... ] Continuous

Fepeating Sequence |nterpolated
----- y Discontinuities

FFE

----- y Discrete . .
K i X Fepeating Sequence Stair
..... i tog:;an:l Bbllt Operations | Sources ||brury
----- ookup Tables
----- 2] Math Operations @ Sl 1| Signal Builder
----- 2] Model Werification —=mn
----- ] Model-wide Utilities Signal Gepersfor

----- 2] Ports & Subsystems
----- 2 signal sttributes

..... 2+ signal Routing
..... ] sirks / E
----- ] sources

----- 2 User-Defined Functions — )
- 2 Additional Math & Discrete Hniferm Fandom Number
- Wl Real-Time workshop LI
Ready

Sine Wave block
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Now drag a copy of the Sine Wave block from the browser and drop it in the
model window.

To copy the Sine Wave block from the Sources library window, open the Sources
window by double-clicking the Sources icon in the Simulink library window.
(On Windows, you can open the Simulink library window by right-clicking the
Simulink node in the Library Browser and then clicking the resulting Open
Library button.)

Simulink displays the Sources library window.
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Now drag the Sine Wave block from the Sources window to your model window.

g [l

File Edit Yiew Simulation Format Tools Help

Sine Wave

Ready [1o0e | [ |odets v

Copy the rest of the blocks in a similar manner from their respective libraries
into the model window. You can move a block from one place in the model
window to another by dragging the block. You can move a block a short distance
by selecting the block, then pressing the arrow keys.

With all the blocks copied into the model window, the model should look
something like this.

Sine Wawe jI> E
- b Scope
=

Integrtor

If you examine the blocks, you see an angle bracket on the right of the Sine
Wave block and two on the left of the Mux block. The > symbol pointing out of
a block is an output port; if the symbol points to a block, it is an input port. A
signal travels out of an output port and into an input port of another block
through a connecting line. When the blocks are connected, the port symbols
disappear.

1
Input port —» — <«—— Output port

s
Integratar

Now it’s time to connect the blocks. Connect the Sine Wave block to the top
input port of the Mux block. Position the pointer over the output port on the
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right side of the Sine Wave block. Notice that the cursor shape changes to
crosshairs.

I =

1 Seope
=
Integrtor

Hold down the mouse button and move the cursor to the top input port of the
Mux block.

Notice that the line is dashed while the mouse button is down and that the
cursor shape changes to double-lined crosshairs as it approaches the Mux
block.

B

Sine Wawve
1 Seope

=
Integrtor

Now release the mouse button. The blocks are connected. You can also connect
the line to the block by releasing the mouse button while the pointer is over the
block. If you do, the line is connected to the input port closest to the cursor’s
position.

Sine Wawve ;I E

1 Seope
=
Integrtor

If you look again at the model at the beginning of this section (see “Building a
Model” on page 1-9), you’ll notice that most of the lines connect output ports of
blocks to input ports of other blocks. However, one line connects a line to the
input port of another block. This line, called a branch line, connects the Sine
Wave output to the Integrator block, and carries the same signal that passes
from the Sine Wave block to the Mux block.



Building a Model

Drawing a branch line is slightly different from drawing the line you just drew.
To weld a connection to an existing line, follow these steps:

First, position the pointer on the line between the Sine Wave and the Mux
block.

Sine Wawve ;I E
=

Seope

Integrtor

Press and hold down the Ctrl key (or click the right mouse button). Press the
mouse button, then drag the pointer to the Integrator block’s input port or
over the Integrator block itself.

Sine Wawve E
el =
T =

Integrtor

Release the mouse button. Simulink draws a line between the starting point
and the Integrator block’s input port.

Integrtor

Finish making block connections. When you’re done, your model should look
something like this.

Integrtor
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Now set up Simulink to run the simulation for 10 seconds. First, open the
Configuration Parameters dialog box by choosing Configuration
Parameters from the Simulation menu. On the dialog box that appears, notice

that the Stop time is set to 10.0 (its default value).

Stop time parameter

E! Configuration Parameters: untitled;/Configuration

Select:

- Solver
- [ ata Import/E xport
- O ptimization
- Diagnostics
L Sample Time
[rata Integrity
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Connectivity
Compatibility

. Model Referencing
- Hardware |mplementation
- Model Referencing

21|
—Simulation time =l
A
Start time: [0.0 Stap time: [T0.0
—Saolver option:
Tupe: I ‘ariable-step VI Solver: I oded5 [Dormand-Prince] LI
Max step size: Iauto Relative tolerance: |1 =3¢}
Min step size: Iauto Absolute tolerance: |auto
Initial step size: Iauto -
Zern crozzing control: I Use local settings 'l
=
Ok I Lancel | Help Apply |

Close the Configuration Parameters dialog box by clicking the OK button.

Simulink applies the parameters and closes the dialog box.

Now double-click the Scope block to open its display window. Finally, choose
Start from the Simulation menu and watch the simulation output on the

Scope.

<) Sco IH[=] E3

|lemop o AaBE

BE R



Building a Model

The simulation stops when it reaches the stop time specified in the
Configuration Parameters dialog box or when you choose Stop from the
Simulation menu or click the Stop button on the model window’s toolbar
(Windows only).

To save this model, choose Save from the File menu and enter a filename and
location. That file contains the description of the model.

To terminate Simulink and MATLAB, choose Exit MATLAB (on a Microsoft
Windows system) or Quit MATLAB (on a UNIX system). You can also enter
quit in the MATLAB Command Window. If you want to leave Simulink but not
terminate MATLAB, just close all Simulink windows.

This exercise shows you how to perform some commonly used model-building
tasks. These and other tasks are described in more detail in Chapter 4,
“Creating a Model.”
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Setting Simulink Preferences

The MATLAB Preferences dialog box allows you to specify default settings for
some Simulink options. To display the Preferences dialog box, select
Preferences from the Simulink File menu.

references 10l =l

General Preferences
AT-Files
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Toolbox path caching
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olors [V Erble toolbox: path cache
= cf Wich
En}:n::boars &DI\:deming ™ Enable toolbox path cache diagnostics
[—Command History Update Toolbox Path Cache
[FEditor Debugger
—Help
] Figure windosw printing
[—Current Directory Specify how colored lines and text are sert to the printer.
—Workspace
|—aray Editor ' Use printer defaultts
_G_UIDE 7 Always send s black and white
gilgure Copy Template
irmLdlink e Alvways send as color
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Miscellaneous Preferences

Selecting Simulink in the left hand pane of the preferences dialog box displays
a Simulink Preferences pane on the right side of the dialog box.

«): Preferences 10l =l

eneral Simulink Preferences

Windowy reuse: | mixed LI
ammand YWincdow

l—Keyboard & Incerting Model Browser

ditorDebugger [ Show masked subsystems
[~ Show library links
Workspace ™ Browser initially visible
Dizplay

[ wide nonscalar lines

[~ Show port data types

[ callback tracing

Ok | Cancel | Apply | Help |

This pane allows you to specify the following Simulink preferences.

Window reuse

Specifies whether Simulink uses existing windows or opens new windows to
display a model’s subsystems (see “Window Reuse” on page 4-24).

Model Browser

Specifies whether Simulink displays the browser when you open a model and
whether the browser shows blocks imported from subsystems and the contents
of masked subsystems (see “The Model Browser” on page 9-22).

Display

Specifies whether to use thick lines to display nonscalar connections between
blocks and whether to display port data types on the block diagram (see
“Working with Signal Groups” on page 6-43).
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Callback tracing

Specifies whether to display the model callbacks that Simulink invokes when
simulating a model (see “Using Callback Functions” on page 4-70).

Font Preferences

Selecting the Fonts subnode of the Simulink node in the left side of the dialog
box displays a stack of tabbed panes on the right side of the dialog box.

<} Preferences =10 x|
- General Simulink Fonts Preferences
F-Command Window
- Command History Blocks | Lines | Annotations |
B~ Editor/Debugger [courier Hew ~l[pain [0 7]
F-Help
Sample
[ Current Directary The quick brown fox jumps ower the lasy
—Workspace dog. LlZ24567890
— Array Editor
—GUIDE
F-Figure Copy Template
E-Sirmulink
Simulation
QK | Cancel | Apply | Help |

The panes allow you to specify your preferred fonts for block and line labels and
model annotations, respectively.
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Simulation Preferences

Selecting the Simulation node beneath the Simulink node in the left side of the
dialog box displays a button to start the Model Explorer (see “The Model
Explorer” on page 9-2).

«): Preferences

[E-General
':gAT-Files
ource Cortrol

+Forts
olors
—HCommand YWindow

l—Keyboard & Incerting
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[FEditor Debugger

—Help
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—Workspace

r—&rray Editar
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g:igure Copy Template
inulink

orts

Simulink Simulation Preferences

Simulation preferences can be accessed only through the "Configuration
Preferences" node in the Simulink model explorer. Click the button below to

launch the Simulink model explorer.

Ok | Cancel | Apply | Help |

=101

Launch model explorer |

Use the Model Explorer to set your simulation preferences.
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How Simulink Works

The following sections explain how Simulink models and simulates dynamic systems. This
information can be helpful in creating models and interpreting simulation results.

Introduction (p. 2-2) Brief overview of Simulink.
Modeling Dynamic Systems (p. 2-3) How Simulink models a dynamic system.
Simulating Dynamic Systems (p. 2-14) How Simulink simulates a dynamic system.

Modeling and Simulating Discrete How Simulink models and simulates discrete systems.
Systems (p. 2-30)
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Introduction

Simulink is a software package that enables you to model, simulate, and
analyze systems whose outputs change over time. Such systems are often
referred to as dynamic systems. Simulink can be used to explore the behavior
of a wide range of real-world dynamic systems, including electrical circuits,
shock absorbers, braking systems, and many other electrical, mechanical, and
thermodynamic systems. This section explains how Simulink works.

Simulating a dynamic system is a two-step process with Simulink. First, a user
creates a block diagram, using the Simulink model editor, that graphically
depicts time-dependent mathematical relationships among the system’s
inputs, states, and outputs. The user then commands Simulink to simulate the
system represented by the model from a specified start time to a specified stop
time.
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Modeling Dynamic Systems

A Simulink block diagram model is a graphical representation of a
mathematical model of a dynamic system. A mathematical model of a dynamic
system is described by a set of equations. The mathematical equations
described by a block diagram model are known as algebraic, differential, and/or
difference equations.

Block Diagram Semantics

A classic block diagram model of a dynamic system graphically consists of
blocks and lines (signals). The history of these block diagram model is derived
from engineering areas such as Feedback Control Theory and Signal
Processing. A block within a block diagram defines a dynamic system in itself.
The relationships between each elementary dynamic system in a block
diagram are illustrated by the use of signals connecting the blocks. Collectively
the blocks and lines in a block diagram describe an overall dynamic system.

Simulink extends these classic block diagram models by introducing the notion
of two classes of blocks, nonvirtual block and virtual blocks. Nonvirtual blocks
represent elementary systems. A virtual block is provided for graphical
organizational convenience and plays no role in the definition of the system of
equations described by the block diagram model. Examples of virtual blocks are
the Bus Creator and Bus Selector which are used to reduce block diagram
clutter by managing groups of signals as a “bundle.” You can use virtual blocks
to improve the readability of your models.

In general, block and lines can be used to describe many “models of
computations.” One example would be a flow chart. A flow chart consists of
blocks and lines, but one cannot describe general dynamic systems using flow
chart semantics.

The term “time-based block diagram” is used to distinguish block diagrams
that describe dynamic systems from that of other forms of block diagrams. In
Simulink, we use the term block diagram (or model) to refer to a time-based
block diagram unless the context requires explicit distinction.

To summarize the meaning of time-based block diagrams:

¢ Simulink block diagrams define time-based relationships between signals
and state variables. The solution of a block diagram is obtained by
evaluating these relationships over time, where time starts at a user
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specified “start time” and ends at a user specified “stop time.” Each
evaluation of these relationships is referred to as a time step.

¢ Signals represent quantities that change over time and are defined for all
points in time between the block diagram’s start and stop time.

¢ The relationships between signals and state variables are defined by a set of
equations represented by blocks. Each block consists of a set of equations
(block methods). These equations define a relationship between the input
signals, output signals and the state variables. Inherent in the definition of
a equation is the notion of parameters, which are the coefficients found
within the equation.

Creating Models

Simulink provides a graphical editor that allows you to create and connect
instances of block types (see Chapter 4, “Creating a Model”) selected from
libraries of block types (see “Simulink Blocks”) via a library browser. Simulink
provides libraries of blocks representing elementary systems that can be used
a building blocks. The blocks supplied with Simulink are called built-in blocks.
Simulink users can also create their own block types and use the Simulink
editor to create instances of them in a diagram. User-defined blocks are called
custom blocks.

Time

Time is an inherent component of block diagrams in that the results of a block
diagram simulation change with time. Put another way, a block diagram
represents the instantaneous behavior of a dynamic system. Determining a
system’s behavior over time thus entails repeatedly solving the model at
intervals, called time steps, from the start of the time span to the end of the
time span. Simulink refers to the process of solving a model at successive time
steps as simulating the system that the model represents..

States

Typically the current values of some system, and hence model, outputs are
functions of the previous values of temporal variables. Such variables are
called states. Computing a model’s outputs from a block diagram hence entails
saving the value of states at the current time step for use in computing the
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outputs at a subsequent time step. Simulink performs this task during
simulation for models that define states.

Two types of states can occur in a Simulink model: discrete and continuous
states. A continuous state changes continuously. Examples of continuous
states are the position and speed of a car. A discrete state is an approximation
of a continuous state where the state is updated (recomputed) using finite
(periodic or aperiodic) intervals. An example of a discrete state would be the
position of a car shown on a digital odometer where it is updated every second
as opposed to continuously. In the limit, as the discrete state time interval
approaches zero, a discrete state becomes equivalent to a continuous state.

Blocks implicitly define a model’s states. In particular, a block that needs some
or all of its previous outputs to compute its current outputs implicitly defines a
set of states that need to be saved between time steps. Such a block is said to
have states.

The following is a graphical representation of a block that has states.

x
U =P (states) >y
(input) (output)

Blocks that define continuous states include the following standard Simulink
blocks:

¢ Integrator

® State-Space
¢ Transfer Fen
® Zero-Pole

The total number of a model’s states is the sum of all the states defined by all
its blocks. Determining the number of states in a diagram requires parsing the
diagram to determine the types of blocks that it contains and then aggregating
the number of states defined by each instance of a block type that defines
states. Simulink performs this task during the Compilation phase of a
simulation.
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Working with States

Simulink provides the following facilities for determining, initializing, and
logging a model’s states during simulation.

® The model command and the Simulink debugger’s states command display
information about the states defined by a model, including the total number
of states defined by the model, the block that defines each state, and the
initial value of each state.

¢ The Simulink debugger displays the value of a state at each time step during
a simulation (see Chapter 13, “Simulink Debugger”).

¢ The Data Import/Export pane of a model’s Configuration Parameters
dialog box (see “Importing and Exporting States” on page 10-22) allows you
to specify initial values for a model’s states and instruct Simulink to record
the values of the states at each time time step during simulation as an array
or structure variable in the MATLAB workspace.

Continuous States

Computing a continuous state entails knowing its rate of change, or derivative.
Since the rate of change of a continuous state typically itself changes
continuously (i.e., is itself a state), computing the value of a continuous state
at the current time step entails integration of its derivative from the start of a
simulation.Thus modeling a continuous state entails representing the
operation of integration and the process of computing the state’s derivative at
each point in time. Simulink block diagrams use Integrator blocks to indicate
integration and a chain of operator blocks connected to the integrator block to
represent the method for computing the state’s derivative. The chain of block’s
connected to the Integrator’s is the graphical counterpart to an ordinary
differential equation (ODE).

In general, excluding simple dynamic systems, analytical methods do not exist
for integrating the states of real-world dynamic systems represented by
ordinary differential equations. Integrating the states requires the use of
numerical methods called ODE solvers. These various methods trade
computational accuracy for computational workload. Simulink comes with
computerized implementations of the most common ODE integration methods
and allows a user to determine which it uses to integrate states represented by
Integrator blocks when simulating a system.
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Computing the value of a continuous state at the current time step entails
integrating its values from the start of the simulation. The accuracy of
numerical integration in turn depends on the size of the intervals between time
steps. In general, the smaller the time step, the more accurate the simulation.
Some ODE solvers, called variable time step solvers, can automatically vary
the size of the time step, based on the rate of change of the state, to achieve a
specified level of accuracy over the course of a simulation. Simulink allows the
user to specify the size of the time step in the case of fixed-step solvers or allow
the solver to determine the step size in the case of variable-step solvers. To
minimize the computation workload, the variable-step solver chooses the
largest step size consistent with achieving an overall level of precision specified
by the user for the most rapidly changing model state. This ensures that all
model states are computed to the accuracy specified by the user.

Discrete States

Computing a discrete state requires knowing the relationship between the
current time and its value at the time at which it previously changed value.
Simulink refers to this relationship as the state’s update function. A discrete
state depends not only on its value at the previous time step but also on the
values of a model’s inputs. Modeling a discrete state thus entails modeling the
state’s dependency on the systems’ inputs at the previous time step. Simulink
block diagrams use specific types of blocks, called discrete blocks, to specify
update functions and chains of blocks connected to the inputs of the block’s to
model the state’s dependency on system inputs.

As with continuous states, discrete states set a constraint on the simulation
time step size. Specifically a step size must be chosen that ensure that all the
sample times of the model’s states are hit. Simulink assigns this task to a
component of the Simulink system called a discrete solver. Simulink provides
two discrete solvers: a fixed-step discrete solver and a variable-step discrete
solver. The fixed-step discrete solver determines a fixed step size that hits all
the sample times of all the model’s discrete states, regardless of whether the
states actually change value at the sample time hits. By contrast, the
variable-step discrete solver varies the step size to ensure that sample time
hits occur only at times when the states change value.

Modeling Hybrid Systems

A hybrid system is a a system that has both discrete and continuous states
Strictly speaking a hybrid model is identified as having continuous and
discrete sample times from which it follows that the model will have
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continuous and discrete states. Solving a model of such a system entails
choosing a step size that satisfies both the precision constraint on the
continuous state integration and the sample time hit constraint on the discrete
states. Simulink meets this requirement by passing the next sample time hit
as determined by the discrete solver as an additional constraint on the
continuous solver. The continuous solver must choose a step size that advances
the simulation up to but not beyond the time of the next sample time hit. The
continuous solver can take a time step short of the next sample time hit to meet
its accuracy constraint but it cannot take a step beyond the next sample time
hit even if its accuracy constraint allows it to.

Block Parameters

Key properties of many standard blocks are parameterized. For example, the
Constant value of the Simulink Constant block is a parameter. Each
parameterized block has a block dialog that lets you set the values of the
parameters. You can use MATLAB expressions to specify parameter values.
Simulink evaluates the expressions before running a simulation. You can
change the values of parameters during a simulation. This allows you to
determine interactively the most suitable value for a parameter.

A parameterized block effectively represents a family of similar blocks. For
example, when creating a model, you can set the Constant value parameter of
each instance of the Constant block separately so that each instance behaves
differently. Because it allows each standard block to represent a family of
blocks, block parameterization greatly increases the modeling power of the
standard Simulink libraries.

Tunable Parameters

Many block parameters are tunable. A tunable parameter is a parameter whose
value can be changed without recompiling the model (see “Model Compilation”
on page 2-14 for more information on compiling a Simulink model). For
example, the gain parameter of the Gain block is tunable. You can alter the
block’s gain while a simulation is running. If a parameter is not tunable and
the simulation is running, Simulink disables the dialog box control that sets
the parameter.
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Note Simulink does not allow you to change the values of source block
parameters through either a dialog box or the Model Explorer while a
simulation is running. Opening the dialog box of a source block with tunable
parameters causes a running simulation to pause. While the simulation is
paused, you can edit the parameter values displayed on the dialog box.
However, you must close the dialog box to have the changes take effect and
allow the simulation to continue.

It should be pointed out that parameter changes do not immediately occur, but
are queued up and then applied at the start of the next time step during model
execution. Returning to our example of the constant block, the function it
defines is signal(t) = ConstantValue for all time. If we were to allow the
constant value to be changed immediately, then the solution at the point in
time at which the change occurred would be invalid. Thus we must queue the
change for processing at the next time step.

You can use the Inline parameters option on the Optimization pane of the
Model Parameter Configuration Dialog Box to specify that all parameters in
your model are nontunable except for those that you specify. This can speed up
execution of large models and enable generation of faster code from your model.
See “Model Parameter Configuration Dialog Box” on page 10-62 for more
information.

Block Sample Times

Every Simulink block is considered to have a sample time, even continuous
blocks (e.g., blocks that define continuous states, such as the Integrator block)
and blocks that do not define states, such as the Gain block. Discrete blocks
allows you to specify their sample times via a Sample Time parameter.
Continuous blocks are considered to have an infinitesimal sample time called
a continuous sample time. A block that is neither discrete or continuous is said
to have an implicit sample time that it inherits from its inputs. The implicit
sample time is continuous if any of the block’s inputs are continuous.
Otherwise, the implicit sample time is discrete. An implicit discrete sample
time is equal to the shortest input sample time if all the input sample times are
integer multiples of the shortest time. Otherwise, the implicit sample time is
equal to the fundamental sample time of the inputs, where the fundamental
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sample time of a set of sample times is defined as the greatest integer divisor
of the set of sample times.

Simulink can optionally color code a block diagram to indicate the sample times
of the blocks it contains, e.g., black (continuous), magenta (constant), yellow
(hybrid), red (fastest discrete), and so on. See “Mixed Continuous and Discrete
Systems” on page 2-39 for more information.

Custom Blocks

Simulink allows you to create libraries of custom blocks that you can then use
in your models. You can create a custom block either graphically or
programmatically. To create a custom block graphically, you draw a block
diagram representing the block’s behavior, wrap this diagram in an instance of
the Simulink Subsystem block, and provide the block with a parameter dialog,
using the Simulink block mask facility. To create a block programmatically,
you create an M-file or a MEX-file that contains the block’s system functions
(see the Writing S-Functions). The resulting file is called an S-function. You
then associate the S-function with instances of the Simulink S-Function block
in your model. You can add a parameter dialog to your S-Function block by
wrapping it in a Subsystem block and adding the parameter dialog to the
Subsystem block.

Systems and Subsystems

A Simulink block diagram can consist of layers. Each layer is defined by a
subsystem. A subsystem is part of the overall block diagram and ideally has no
impact on the meaning of the block diagram. Subsystems are provided
primarily to help in the organization aspects a block diagram. Subsystems do
not define a separate block diagram.

Simulink differentiates between two different types of subsystems: virtual and
nonvirtual. The main difference is that nonvirtual subsystems provide the
ability to control when the contents of the subsystem are evaluated.

Flattening the Model Hierarchy

While preparing a model for execution, Simulink generates internal “systems”
that are collections of block methods (equations) that are evaluated together.
The semantics of time-based block diagrams doesn’t require creation of these
systems. Simulink creates these internal systems as a means to manage the
execution of the model. Roughly speaking, there will be one system for the
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top-level block diagram which is referred to as the root system, and several
lower-level systems derived from nonvirtual subsystems and other elements in
the block diagram. You will see these systems in the Simulink Debugger. The
act of creating these internal systems is often referred to as flattening the
model hierarchy.

Conditionally Executed Subsystems

You can create conditionally executed subsystems that are executed only when
a transition occurs on a triggering, function-call, action, or enabling input (see
“Creating Conditionally Executed Subsystems” on page 4-27). Conditionally
executed subsystems are atomic, i.e., the equations that they define are
evaluated as a unit.

Atomic Subsystems

Unconditionally executed subsystems are virtual by default. You can, however,
designate an unconditionally executed subsystem as atomic (see the Atomic
Subsystem block). This is useful if you need to ensure that the equations
defined by a subsystem are evaluated as a unit.

Signals

Simulink uses the term signal to refer to a time varying quantity that has
values at all points in time. Simulink allows you to specify a wide range of
signal attributes, including signal name, data type (e.g., 8-bit, 16-bit, or 32-bit
integer), numeric type (real or complex), and dimensionality (one-dimensional
or two-dimensional array). Many blocks can accept or output signals of any
data or numeric type and dimensionality. Others impose restrictions on the
attributes of the signals they can handle.

On the block diagram, you will find that the signals are represented with lines
that have an arrow head. The source of the signal corresponds to the block that
writes to the signal during evaluation of its block methods (equations). The
destinations of the signal are blocks that read the signal during the evaluation
of its block methods (equations). A good analogy of the meaning of a signal is to
consider a classroom. The teacher is the one responsible for writing on the
white board and the students read what is written on the white board when
they choose to. This is also true of Simulink signals, a reader of the signal (a
block method) can choose to read the signal as frequently or infrequently as so
desired.

2-11



2 How Simulink Works

Block Methods

Blocks represent multiple equations. These equations are represented as block
methods within Simulink. These block methods are evaluated (executed)
during the execution of a block diagram. The evaluation of these block methods
is performed within a simulation loop, where each cycle through the simulation
loop represent evaluation of the block diagram at a given point in time.

Method Types

Simulink assigns names to the types of functions performed by block methods.
Common method types include:

® QOutputs

Computes the outputs of a block given its inputs at the current time step and
its states at the previous time step.

¢ Update

Computes the value of the block’s discrete states at the current time step,
given its inputs at the current time step and its discrete states at the
previous time step.

® Derivatives

Computes the derivatives of the block’s continuous states at the current time
step, given the block’s inputs and the values of the states at the previous time
step.

Method Naming Convention

Block methods perform the same types of operations in different ways for
different types of blocks. The Simulink user interface and documentation uses
dot notation to indicate the specific function performed by a block method:

BlockType.MethodType

For example, Simulink refers to the method that computes the outputs of a
Gain block as

Gain.Outputs

The Simulink debugger takes the naming convention one step further and uses
the instance name of a block to specify both the method type and the block
instance on which the method is being invoked during simulation, e.g.,
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g1.0utputs

Model Methods

In addition to block methods, Simulink also provides a set of methods that
compute the model’s properties and its outputs. Simulink similarly invokes
these methods during simulation to determine a model’s properties and its
outputs. The model methods generally perform their tasks by invoking block
methods of the same type. For example, the model Outputs method invokes the
Outputs methods of the blocks that it contains in the order specified by the
model to compute its outputs. The model Derivatives method similarly invokes
the Derivatives methods of the blocks that it contains to determine the
derivatives of its states.
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Simulating Dynamic Systems

Simulating a dynamic system refers to the process of computing a system’s
states and outputs over a span of time, using information provided by the
system’s model. Simulink simulates a system when you choose Start from the
model editor’s Simulation menu, with the system’s model open.

A Simulink component called the Simulink Engine responds to a Start
command, performing the following steps.

Model Compilation

First, the Simulink engine invokes the model compiler. The model compiler
converts the model to an executable form, a process called compilation. In
particular, the compiler

¢ Evaluates the model’s block parameter expressions to determine their
values.

® Determines signal attributes, e.g., name, data type, numeric type, and
dimensionality, not explicitly specified by the model and checks that each
block can accept the signals connected to its inputs.

¢ Simulink uses a process called attribute propagation to determine

unspecified attributes. This process entails propagating the attributes of a
source signal to the inputs of the blocks that it drives.

¢ Performs block reduction optimizations.

¢ Flattens the model hierarchy by replacing virtual subsystems with the
blocks that they contain (see “Solvers” on page 2-17).

¢ Determines the block sorted order (see “Controlling and Displaying the
Sorted Order” on page 5-22 for more information).

¢ Determines the sample times of all blocks in the model whose sample times
you did not explicitly specify (see “Sample Time Propagation” on page 2-35).

Link Phase

In this phase, the Simulink Engine allocates memory needed for working areas
(signals, states, and run-time parameters) for execution of the block diagram.
It also allocates and initializes memory for data structures that store run-time
information for each block. For built-in blocks, the principal run-time data
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structure for a block is called the SimBlock. It stores pointers to a block’s input
and output buffers and state and work vectors.

Method Execution Lists

In the Link phase, the Simulink engine also creates method execution lists.
These lists list the most efficient order in which to invoke a model’s block
methods to compute its outputs. Simulink uses the block sorted order lists
generated during the model compilation phase to construct the method
execution lists.

Block Priorities

Simulink allows you to assign update priorities to blocks (see “Assigning Block
Priorities” on page 5-24). Simulink executes the output methods of higher
priority blocks before those of lower priority blocks. Simulink honors the
priorities only if they are consistent with its block sorting rules.

Simulation Loop Phase

The simulation now enters the simulation loop phase. In this phase, the
Simulink engine successively computes the states and outputs of the system at
intervals from the simulation start time to the finish time, using information
provided by the model. The successive time points at which the states and
outputs are computed are called time steps. The length of time between steps
is called the step size. The step size depends on the type of solver (see “Solvers”
on page 2-17) used to compute the system’s continuous states, the system’s
fundamental sample time (see “Modeling and Simulating Discrete Systems” on
page 2-30), and whether the system’s continuous states have discontinuities
(see “Zero-Crossing Detection” on page 2-19).

The Simulation Loop phase has two subphases: the Loop Initialization phase
and the Loop Iteration phase. The initialization phase occurs once, at the start
of the loop. The iteration phase is repeated once per time step from the
simulation start time to the simulation stop time.

At the start of the simulation, the model specifies the initial states and outputs
of the system to be simulated. At each step, Simulink computes new values for
the system’s inputs, states, and outputs and updates the model to reflect the
computed values. At the end of the simulation, the model reflects the final
values of the system’s inputs, states, and outputs. Simulink provides data
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display and logging blocks. You can display and/or log intermediate results by
including these blocks in your model.

Loop Iteration
At each time step, the Simulink Engine

1 Computes the model’s outputs.

The Simulink Engine initiates this step by invoking the Simulink model
Outputs method.The model Outputs method in turn invokes the model
system Outputs method, which invokes the Outputs methods of the blocks
that the model contains in the order specified by the Outputs method
execution lists generated in the Link phase of the simulation (see “Solvers”
on page 2-17).

The system Outputs method passes the following arguments to each block
Outputs method: a pointer to the block’s data structure and to its SimBlock
structure. The SimBlock data structures point to information that the
Outputs method needs to compute the block’s outputs, including the location
of its input buffers and its output buffers.

2 Computes the model’s states.

The Simulink Engine computes a model’s states by invoking a solver. Which
solver it invokes depends on whether the model has no states, only discrete
states, only continuous states, or both continuous and discrete states.

If the model has only discrete states, the Simulink Engine invokes the
discrete solver selected by the user. The solver computes the size of the time
step needed to hit the model’s sample times. It then invokes the Update
method of the model. The model Update method invokes the Update method
of its system, which invokes the Update methods of each of the blocks that
the system contains in the order specified by the Update method lists
generated in the Link phase.

If the model has only continuous states, the Simulink Engine invokes the
continuous solver specified by the model. Depending on the solver, the solver
either in turn calls the Derivatives method of the model once or enters a
subcycle of minor time steps where the solver repeatedly calls the model’s
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Outputs methods and Derivatives methods to compute the model’s outputs
and derivatives at successive intervals within the major time step. This is
done to increase the accuracy of the state computation. The model Outputs
method and Derivatives methods in turn invoke their corresponding system
methods, which invoke the block Outputs and Derivatives in the order
specified by the Outputs and Derivatives methods execution lists generated
in the Link phase.

3 Optionally checks for discontinuities in the continuous states of blocks.

Simulink uses a technique called zero-crossing detection to detect
discontinuities in continuous states. See “Zero-Crossing Detection” on
page 2-19 for more information.

4 Computes the time for the next time step.

Simulink repeats steps 1 through 4 until the simulation stop time is reached.

Solvers

Simulink simulates a dynamic system by computing its states at successive
time steps over a specified time span, using information provided by the model.
The process of computing the successive states of a system from its model is
known as solving the model. No single method of solving a model suffices for all
systems. Accordingly, Simulink provides a set of programs, known as solvers,
that each embody a particular approach to solving a model. The Configuration
Parameters dialog box allows you to choose the solver most suitable for your
model (see “Choosing a Solver Type” on page 10-7).

Fixed-Step Solvers Versus Variable-Step Solvers
Simulink solvers fall into two basic categories: fixed-step and variable-step.

Fixed-step solvers solve the model at regular time intervals from the beginning
to the end of the simulation. The size of the interval is known as the step size.
You can specify the step size or let the solver choose the step size. Generally,
decreasing the step size increases the accuracy of the results while increasing
the time required to simulate the system.

Variable-step solvers vary the step size during the simulation, reducing the
step size to increase accuracy when a model’s states are changing rapidly and

2-17



2 How Simulink Works

increasing the step size to avoid taking unnecessary steps when the model’s
states are changing slowly. Computing the step size adds to the computational
overhead at each step but can reduce the total number of steps, and hence
simulation time, required to maintain a specified level of accuracy for models
with rapidly changing or piecewise continuous states.

Continuous Versus Discrete Solvers
Simulink provides both continuous and discrete solvers.

Continuous solvers use numerical integration to compute a model’s continuous
states at the current time step from the states at previous time steps and the
state derivatives. Continuous solvers rely on the model’s blocks to compute the
values of the model’s discrete states at each time step.

Mathematicians have developed a wide variety of numerical integration
techniques for solving the ordinary differential equations (ODEs) that
represent the continuous states of dynamic systems. Simulink provides an
extensive set of fixed-step and variable-step continuous solvers, each
implementing a specific ODE solution method (see “Choosing a Solver Type” on
page 10-7).

Discrete solvers exist primarily to solve purely discrete models. They compute
the next simulation time step for a model and nothing else. They do not
compute continuous states and they rely on the model’s blocks to update the
model’s discrete states.

Note You can use a continuous solver, but not a discrete solver, to solve a
model that contains both continuous and discrete states. This is because a
discrete solver does not handle continuous states. If you select a discrete
solver for a continuous model, Simulink disregards your selection and uses a
continuous solver instead when solving the model.

Simulink provides two discrete solvers, a fixed-step discrete solver and a
variable-step discrete solver. The fixed-step solver by default chooses a step
size and hence simulation rate fast enough to track state changes in the fastest
block in your model. The variable-step solver adjusts the simulation step size
to keep pace with the actual rate of discrete state changes in your model. This
can avoid unnecessary steps and hence shorten simulation time for multirate
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models (see “Determining Step Size for Discrete Systems” on page 2-34 for
more information).

Minor Time Steps

Some continuous solvers subdivide the simulation time span into major and
minor time steps, where a minor time step represents a subdivision of the
major time step. The solver produces a result at each major time step. It uses
results at the minor time steps to improve the accuracy of the result at the
major time step.

Zero-Crossing Detection

When simulating a dynamic system, Simulink checks for discontinuities in the
system’s state variables at each time step, using a technique known as
zero-crossing detection. If Simulink detects a discontinuity within the current
time step, it determines the precise time at which the discontinuity occurs and
takes additional time steps before and after the discontinuity. This section
explains why zero-crossing detection is important and how it works.

Discontinuities in state variables often coincide with significant events in the
evolution of a dynamic system. For example, the instant when a bouncing ball
hits the floor coincides with a discontinuity in its velocity. Because
discontinuities often indicate a significant change in a dynamic system, it is
important to simulate points of discontinuity precisely. Otherwise, a
simulation could lead to false conclusions about the behavior of the system
under investigation. Consider, for example, a simulation of a bouncing ball. If
the point at which the ball hits the floor occurs between simulation steps, the
simulated ball appears to reverse position in midair. This might lead an
investigator to false conclusions about the physics of the bouncing ball.

To avoid such misleading conclusions, it is important that simulation steps
occur at points of discontinuity. A simulator that relies purely on solvers to
determine simulation times cannot efficiently meet this requirement.
Consider, for example, a fixed-step solver. A fixed-step solver computes the
values of state variables at integral multiples of a fixed step size. However,
there is no guarantee that a point of discontinuity will occur at an integral
multiple of the step size. You could reduce the step size to increase the
probability of hitting a discontinuity, but this would greatly increase the
execution time.
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A variable-step solver appears to offer a solution. A variable-step solver adjusts
the step size dynamically, increasing the step size when a variable is changing
slowly and decreasing the step size when the variable changes rapidly. Around
a discontinuity, a variable changes extremely rapidly. Thus, in theory, a
variable-step solver should be able to hit a discontinuity precisely. The problem
is that to locate a discontinuity accurately, a variable-step solver must again
take many small steps, greatly slowing down the simulation.

How Zero-Crossing Detection Works

Simulink uses a technique known as zero-crossing detection to address this
problem. With this technique, a block can register a set of zero-crossing
variables with Simulink, each of which is a function of a state variable that can
have a discontinuity. The zero-crossing function passes through zero from a
positive or negative value when the corresponding discontinuity occurs. At the
end of each simulation step, Simulink asks each block that has registered
zero-crossing variables to update the variables. Simulink then checks whether
any variable has changed sign since the last step. Such a change indicates that
a discontinuity occurred in the current time step.

If any zero crossings are detected, Simulink interpolates between the previous
and current values of each variable that changed sign to estimate the times of
the zero crossings (e.g., discontinuities). Simulink then steps up to and over
each zero crossing in turn. In this way, Simulink avoids simulating exactly at
the discontinuity, where the value of the state variable might be undefined.

Zero-crossing detection enables Simulink to simulate discontinuities
accurately without resorting to excessively small step sizes. Many Simulink
blocks support zero-crossing detection. The result is fast and accurate
simulation of all systems, including systems with discontinuities.

Implementation Details

An example of a Simulink block that uses zero crossings is the Saturation
block. Zero crossings detect these state events in the Saturation block:

® The input signal reaches the upper limit.

¢ The input signal leaves the upper limit.

¢ The input signal reaches the lower limit.

® The input signal leaves the lower limit.
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Simulink blocks that define their own state events are considered to have
intrinsic zero crossings. If you need explicit notification of a zero-crossing event,
use the Hit Crossing block. See “Blocks with Zero Crossings” on page 2-22 for
a list of blocks that incorporate zero crossings.

The detection of a state event depends on the construction of an internal
zero-crossing signal. This signal is not accessible by the block diagram. For the
Saturation block, the signal that is used to detect zero crossings for the upper
limit is zcSignal = UpperLimit — u, where u is the input signal.

Zero-crossing signals have a direction attribute, which can have these values:

® rising — A zero crossing occurs when a signal rises to or through zero, or when
a signal leaves zero and becomes positive.

® falling — A zero crossing occurs when a signal falls to or through zero, or
when a signal leaves zero and becomes negative.

® cither — A zero crossing occurs if either a rising or falling condition occurs.

For the Saturation block’s upper limit, the direction of the zero crossing is
either. This enables the entering and leaving saturation events to be detected
using the same zero-crossing signal.

If the error tolerances are too large, it is possible for Simulink to fail to detect
a zero crossing. For example, if a zero crossing occurs within a time step, but
the values at the beginning and end of the step do not indicate a sign change,
the solver steps over the crossing without detecting it.

The following figure shows a signal that crosses zero. In the first instance, the
integrator steps over the event. In the second, the solver detects the event.

y
]
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If you suspect this is happening, tighten the error tolerances to ensure that the
solver takes small enough steps. For more information, see “Maximum order”
on page 10-40.
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Note Using the Refine output option (see “Output options” on page 10-49)
does not help locate the missed zero crossings. You should alter the maximum
step size or output times.

Caveat

It is possible to create models that exhibit high-frequency fluctuations about a
discontinuity (chattering). Such systems typically are not physically realizable;
a massless spring, for example. Because chattering causes repeated detection
of zero crossings, the step sizes of the simulation become very small, essentially
halting the simulation.

If you suspect that this behavior applies to your model, you can use the Zero
crossing control option on the Solver pane of the Configuration Parameters
dialog box (see “Zero crossing control” on page 10-38) to disable zero-crossing
detection. Although disabling zero-crossing detection can alleviate the
symptoms of this problem, you no longer benefit from the increased accuracy
that zero-crossing detection provides. A better solution is to try to identify the
source of the underlying problem in the model.

Blocks with Zero Crossings

The following table lists blocks that use zero crossings and explains how the
blocks use the zero crossings:

Block Description of Zero Crossing

Abs One: to detect when the input signal crosses zero in either
the rising or falling direction.

Backlash Two: one to detect when the upper threshold is engaged,
and one to detect when the lower threshold is engaged.

Dead Zone Two: one to detect when the dead zone is entered (the input
signal minus the lower limit), and one to detect when the
dead zone is exited (the input signal minus the upper
limit).
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Block Description of Zero Crossing (Continued)

Hit One: to detect when the input crosses the threshold.

Crossing

Integrator If the reset port is present, to detect when a reset occurs. If
the output is limited, there are three zero crossings: one to
detect when the upper saturation limit is reached, one to
detect when the lower saturation limit is reached, and one
to detect when saturation is left.

MinMax One: for each element of the output vector, to detect when
an input signal is the new minimum or maximum.

Relay One: if the relay is off, to detect the switch on point. If the
relay is on, to detect the switch off point.

Relational One: to detect when the output changes.

Operator

Saturation Two: one to detect when the upper limit is reached or left,
and one to detect when the lower limit is reached or left.

Sign One: to detect when the input crosses through zero.

Step One: to detect the step time.

Subsystem For conditionally executed subsystems: one for the enable
port if present, and one for the trigger port, if present.

Switch One: to detect when the switch condition occurs.

Algebraic Loops

Some Simulink blocks have input ports with direct feedthrough. This means
that the output of these blocks cannot be computed without knowing the values
of the signals entering the blocks at these input ports. Some examples of blocks
with direct feedthrough inputs are as follows:

® The Math Function block
® The Gain block
® The Integrator block’s initial condition ports
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® The Product block
® The State-Space block when there is a nonzero D matrix
® The Sum block

® The Transfer Fen block when the numerator and denominator are of the
same order

e The Zero-Pole block when there are as many zeros as poles

An algebraic loop generally occurs when an input port with direct feedthrough
is driven by the output of the same block, either directly, or by a feedback path
through other blocks with direct feedthrough. An example of an algebraic loop
is this simple scalar loop.

u
— e+ :
I
-

Mathematically, this loop implies that the output of the Sum block is an
algebraic state z constrained to equal the first input # minus z (i.e. z = u - 2).
The solution of this simple loop is z = u/2, but most algebraic loops cannot be
solved by inspection.

It is easy to create vector algebraic loops with multiple algebraic state variables
z1, z2, etc., as shown in this model.

-+
z1 4zl-1 Solve z1 Ijl
>+ i) T E >
- Algebraic Constraint Display =1
Sum
2l o
- —
72 z2-z1-1 Solve z2
-+ B ol - !
1 - — Algebraic Constraintd Display =2
Constant Sumi

The Algebraic Constraint block is a convenient way to model algebraic
equations and specify initial guesses. The Algebraic Constraint block
constrains its input signal F(z) to zero and outputs an algebraic state z. This
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block outputs the value necessary to produce a zero at the input. The output
must affect the input through some feedback path. You can provide an initial
guess of the algebraic state value in the block’s dialog box to improve algebraic
loop solver efficiency.

A scalar algebraic loop represents a scalar algebraic equation or constraint of
the form F(z) = 0, where z is the output of one of the blocks in the loop and the
function F consists of the feedback path through the other blocks in the loop to
the input of the block. In the simple one-block example shown on the previous
page, F(z) =z — (u - z). In the vector loop example shown above, the equations
are

22+42z1-1=0
22-21-1=0

Algebraic loops arise when a model includes an algebraic constraint F(z) = 0.

This constraint might arise as a consequence of the physical interconnectivity
of the system you are modeling, or it might arise because you are specifically

trying to model a differential/algebraic system (DAE).

When a model contains an algebraic loop, Simulink calls a loop solving routine
at each time step. The loop solver performs iterations to determine the solution
to the problem (if it can). As a result, models with algebraic loops run slower
than models without them.

To solve F(z) = 0, the Simulink loop solver uses Newton’s method with weak
line search and rank-one updates to a Jacobian matrix of partial derivatives.
Although the method is robust, it is possible to create loops for which the loop
solver will not converge without a good initial guess for the algebraic states z.
You can specify an initial guess for a line in an algebraic loop by placing an IC
block (which is normally used to specify an initial condition for a signal) on that
line. As shown above, another way to specify an initial guess for a line in an
algebraic loop is to use an Algebraic Constraint block.

Whenever possible, use an IC block or an Algebraic Constraint block to specify
an initial guess for the algebraic state variables in a loop.

Highlighting Algebraic Loops

You can cause Simulink to highlight algebraic loops when you update,
simulate, or debug a model. Use the ashow command to highlight algebraic
loops when debugging a model.
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To cause Simulink to highlight algebraic loops that it detects when updating or
simulating a model, set the Algebraic loop diagnostic on the Diagnostics
pane of the Configuration Parameters dialog box to Error (see “The
Configuration Parameters Dialog Box” on page 10-35 for more information).
This causes Simulink to display an error dialog (the Diagnostics Viewer) and
recolor portions of the diagram that represent the algebraic loops that it
detects. Simulink uses red to color the blocks and lines that constitute the
loops. Closing the error dialog restores the diagram to its original colors.

For example, the following figure shows the block diagram of the hydcyl demo
model in its original colors.
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The following figure shows the diagram after updating when the Algebraic
loop diagnostic is set to Error.
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In this example, Simulink has colored the algebraic loop red, making it stand
out from the rest of the diagram.

]
k J

¥

Eliminating Algebraic Loops
Simulink can eliminate some algebraic loops that include any of the following
types of blocks:

® Atomic Subsystem
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¢ Enabled Subsystem
® Model

To enable automatic algebraic loop elimination for a loop involving a particular
instance of an Atomic Subsystem or Enabled Subsystem block, select the
Minimize algebraic loop occurrences parameter on the block’s parameters
dialog box. To enable algebraic loop elimination for a loop involving a Model
block, check the Minimize algebraic loop occurrences parameter on the
Model Referencing configuration parameters dialog (see “Model Referencing
Pane” on page 10-84) of the model referenced by the Model block. If a loop
includes more than one instance of these blocks, you should enable algebraic
loop elimination for all of them, including nested blocks.

The Simulink Minimize algebraic loop solver diagnostic allows you to specify
the action Simulink should take, for example, display a warning message, if it
is unable to eliminate an algebraic loop involving a block for which algebraic
loop elimination is enabled. See “The Diagnostics Pane” on page 10-63 for more
information.

Algebraic loop minimization is off by default because it is incompatible with
conditional input branch optimization in Simulink (see “The Optimization
Pane” on page 10-50) and with single output/update function optimization in
Real-Time Workshop . If you need these optimizations for an atomic or
enabled subsystem or referenced model involved in an algebraic loop, you must
eliminate the algebraic loop yourself.

As an example of the ability of Simulink to eliminate algebraic loops, consider
the following model.

|

Gain Integrator

Im Outt

Constant 5 o -
Atomic Subsystem
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Simulating this model with the solver’s Algebraic Loop diagnostic set to error
(see “The Diagnostics Pane” on page 10-63) reveals that this model contains an

algebraic loop involving its atomic subsystem.

Constant

Imi

Cut

Atomic Subsystam

e

\J"‘

Gain

Checking the atomic subsystem’s Minimize algebraic loop occurrences

parameter causes Simulink to eliminate the algebraic loop from the compiled
version of the model.

Constant

Im

Outt

Atomic Subsystem

i

AN
]

Gain

[=1Block Parameters: Atomic Subsystem 2lx|
Select the settings for the subsystem block.
¥ {Show port labels!
Read/wite pemissions: | Readwiite =l
Name of error callback function:
Permit hierarchical resolution: [ Al |
[V Treat as atomic urit
[¥ Minimize slgsbraic loop occurtsnces
Sample time -1 for inherted):
[
AT spstem code: | Auto = |
RTW function nams options: [ 4.t =l
RTW file name options. | Auto j
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As a result, the model now simulates without error.

Im Outt

Constant Atomic Subsystem

Note that Simulink is able to eliminate the algebraic loop involving this
model’s atomic subsystem because the atomic subsystem contains a block with
a port that does not have direct feed through, i.e., the Integrator block.

If you remove the Integrator block from the atomic subsystem, Simulink is
unable to eliminate the algebraic loop. Hence, attempting to simulate the
model results in an error.

-7 In1 [ outt

Gain

Imi Cut

Constant 5 — o
Atomic Subsystam
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Modeling and Simulating Discrete Systems

Simulink has the ability to simulate discrete (sampled data) systems, including
systems whose components operate at different rates (multirate systems) and
systems that mix discrete and continuous components (hybrid systems). This

capability stems from two key Simulink features:

® SampleTime block parameter

Some Simulink blocks have a SampleTime parameter that you can use to
specify the block’s sample time, i.e., the rate at which it executes during
simulation. All blocks have either an explicit or implicit sample time
parameter. Continuous blocks are examples of blocks that have an implicit
(continuous) sample time. It is possible for a block to have multiple sample
times as provided with blocksets such as the Signal Processing Blockset or
created by a user using the S-Function block.

e Sample-time inheritance

Most standard Simulink blocks can inherit their sample time from the blocks
connected to their inputs. Exceptions include blocks in the Continuous
library and blocks that do not have inputs (e.g., blocks from the Sources
library). In some cases, source blocks can inherit the sample time of the block
connected to its input.

The ability to specify sample times on a block-by-block basis, either directly
through the SampleTime parameter or indirectly through inheritance, enables
you to model systems containing discrete components operating at different
rates and hybrid systems containing discrete and continuous components.

Specifying Sample Time

Simulink allows you to specify the sample time of any block that has a
SampleTime parameter. You can use the block’s parameter dialog box to set this
parameter. You do this by entering the sample time in the Sample time field
on the dialog box. You can enter either the sample time alone or a vector whose
first element is the sample time and whose second element is an offset: [T,
Tol. Various values of the sample time and offset have special meanings.
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The following table summarizes valid values for this parameter and how
Simulink interprets them to determine a block’s sample time.

Sample Time

Usage

[Ts, Tol
0> Ts < Tsim

| Tol < Tp

[0, 01,

[0,

1]

0

Specifies that updates occur at simulation times
th =n * Tg + [T,

where n is an integer in the range 1..74;,/Ts and
Tgim 1s the length of the simulation. Blocks that
have a sample time greater than 0 are said to have
a discrete sample time.

The offset allows you to specify that Simulink
update the block later in the sample interval than
other blocks operating at the same rate.

Specifies that updates occur at every major and
minor time step. A block that has a sample time of
0 is said to have a continuous sample time.

Specifies that updates occur only at major time
steps, skipping minor time steps (see “Minor Time
Steps” on page 2-19). This setting avoids
unnecessary computations for blocks whose sample
time cannot change between major time steps. The
sample time of a block that executes only at major
time steps is said to be fixed in minor time step.
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Sample Time

Usage

[-1, 0], -1

inf

If the block is not in a triggered subsystem, this
setting specifies that the block inherits its sample
time from the block connected to its input
(inheritance) or, in some cases, from the block
connected to its output (back inheritance). If the
block is in a triggered subsystem, you must set the
SampleTime parameter to this setting.

Note that specifying sample-time inheritance for a
source block can cause Simulink to assign an
inappropriate sample time to the block if the source
drives more than one block. For this reason, you
should avoid specifying sample-time inheritance for
source blocks. If you do, Simulink displays a
warning message when you update or simulate the
model.

The meaning of this sample time depends on
whether the active model configuration’s inline
parameters optimization (see “Inline parameters”
on page 10-54) is enabled. If the inline parameters
optimization is enabled, inf signifies that the
block’s output can never change (see “Constant
Sample Time” on page 2-37). This speeds up
simulation and the generated code by eliminating
the need to recompute the block’s output at each
time step. If the inline parameters optimization is
disabled or the block with inf sample time drives
an output port of a conditionally executed
subsystem, Simulink treats inf as -1, i.e., as
inherited sample time. This allows you to tune the
block’s parameters during simulation.
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Changing a Block’s Sample Time

You cannot change the SampleTime parameter of a block while a simulation is
running. If you want to change a block’s sample time, you must stop and restart
the simulation for the change to take effect.

Compiled Sample Time

During the compilation phase of a simulation, Simulink determines the sample
time of the block from its SampleTime parameter (if it has a SampleTime
parameter), sample-time inheritance, or block type (Continuous blocks always
have a continuous sample time). It is this compiled sample time that
determines the sample rate of a block during simulation. You can determine
the compiled sample time of any block in a model by first updating the model
and then getting the block’s CompiledSampleTime parameter, using the
get_param command.

Purely Discrete Systems

Purely discrete systems can be simulated using any of the solvers; there is no
difference in the solutions. To generate output points only at the sample hits,
choose one of the discrete solvers.

Multirate Systems

Multirate systems contain blocks that are sampled at different rates. These
systems can be modeled with discrete blocks or with both discrete and

continuous blocks. For example, consider this simple multirate discrete model.

¥

z+0.1 : :
=02 ;
[1] | DTF .
Canstant z+0.1 ) [:)
=02

DTF2 2

¥

For this example the DTF1 Discrete Transfer Fcn block’s Sample time is set to
[1 0.1], which gives it an offset of 0. 1. The DTF2 Discrete Transfer Fcn block’s
Sample time is set to 0.7, with no offset.

Starting the simulation (see “Running a Simulation Programmatically” on
page 10-95) and plotting the outputs using the stairs function
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[t,x,y] = sim('multirate', 3);
stairs(t,y)

produces this plot

y(2).

y(1)

For the DTF1 block, which has an offset of 0. 1, there is no output until t = 0.1.
Because the initial conditions of the transfer functions are zero, the output of
DTF1, y(1), is zero before this time.

Determining Step Size for Discrete Systems

Simulating a discrete system requires that the simulator take a simulation
step at every sample time hit, that is, at integer multiples of the system’s
shortest sample time. Otherwise, the simulator might miss key transitions in
the system’s states. Simulink avoids this by choosing a simulation step size to
ensure that steps coincide with sample time hits. The step size that Simulink
chooses depends on the system’s fundamental sample time and the type of
solver used to simulate the system.

The fundamental sample time of a discrete system is the greatest integer
divisor of the system’s actual sample times. For example, suppose that a
system has sample times of 0.25 and 0.5 second. The fundamental sample time
in this case is 0.25 second. Suppose, instead, the sample times are 0.5 and 0.75
second. In this case, the fundamental sample time is again 0.25 second.

You can direct Simulink to use either a fixed-step or a variable-step discrete
solver to solve a discrete system. A fixed-step solver sets the simulation step
size equal to the discrete system’s fundamental sample time. A variable-step
solver varies the step size to equal the distance between actual sample time
hits. The following diagram illustrates the difference between a fixed-step and
a variable-size solver.
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In the diagram, arrows indicate simulation steps and circles represent sample
time hits. As the diagram illustrates, a variable-step solver requires fewer
simulation steps to simulate a system, if the fundamental sample time is less
than any of the actual sample times of the system being simulated. On the
other hand, a fixed-step solver requires less memory to implement and is faster
if one of the system’s sample times is fundamental. This can be an advantage
in applications that entail generating code from a Simulink model (using
Real-Time Workshop®).

Sample Time Propagation

When updating a model’s diagram, for example, at the beginning of a
simulation, Simulink uses a process called sample time propagation to
determine the sample times of blocks that inherit their sample times. The
figure below illustrates a Discrete Filter block with a sample time of Ts driving
a Gain block.

1
_b. _
1+zz1

Dizcrete Filter Gain
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Because the Gain block’s output is simply the input multiplied by a constant,
its output changes at the same rate as the filter. In other words, the Gain block
has an effective sample rate equal to that of the filter’s sample rate. This is the
fundamental mechanism behind sample time propagation in Simulink.

Simulink assigns an inherited sample time to a block based on the sample
times of the blocks connected to its inputs, using the following rules.

e If all the inputs have the same sample time, Simulink assigns that sample
time to the block.

e If the inputs have different sample times and if all the input sample times
are integer multiples of the fastest input sample time, the block is assigned
the sample time of the fastest input.

e Ifthe inputs have different sample times and some of the input sample times
are not integer multiples of the fastest sample time and a variable-step
solver is being used, the block is assigned continuous sample time.

¢ Ifthe inputs have different sample times and some of the input sample times
are not integer multiples of the fastest sample time and a fixed-step solver is
being used, and the greatest common divisor of the sample times (the
fundamental sample time) can be computed, the block is assigned the
fundamental sample time; otherwise, in this case, the block is assigned
continuous sample time.

Note A Model block can inherit its sample time from its inputs only if the
inputs and outputs of the model that it references do not depend on the
sample time (see “Model Block Sample Times” on page 4-52 for more
information).

Under some circumstances, Simulink also back propagates sample times to
source blocks if it can do so without affecting the output of a simulation. For
instance, in the model below, Simulink recognizes that the Signal Generator
block is driving a Discrete-Time Integrator block, so it assigns the Signal
Generator block and the Gain block the same sample time as the Discrete-Time
Integrator block.
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Signal Discrete-Time Gain
Generator Integratar

You can verify this by selecting Sample Time Colors from the Simulink
Format menu and noting that all blocks are colored red. Because the
Discrete-Time Integrator block only looks at its input at its sample times, this
change does not affect the outcome of the simulation but does result in a
performance improvement.

Replacing the Discrete-Time Integrator block with a continuous Integrator
block, as shown below, and recoloring the model by choosing Update diagram
from the Edit menu cause the Signal Generator and Gain blocks to change to
continuous blocks, as indicated by their being colored black.

ooog 1
oo > -
=

Signal Integrator Gain
Generator

Constant Sample Time

A block whose whose output cannot change from its initial value during a
simulation is said to have constant sample time. A block has constant sample
time if it satisfies both of the following conditions:

¢ All of its parameters are nontunable, either because they are inherently
nontunable or because they have been inlined (see “Inline parameters” on
page 10-54).

® The block’s sample time has been declared infinite (inf) or its sample time is
declared to be inherited and it inherits a constant sample time from another
block to which it is connected.

When Simulink updates a model, for example, at the beginning of a simulation,
Simulink determines which blocks, if any, have constant sample time, and
computes the initial values of the output ports. During the simulation,
Simulink uses the initial values whenever the outputs of blocks with constant
sample time are required, thus avoiding unnecessary computations.
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You can determine which blocks have constant sample time by selecting
Sample Time Colors from the Format menu and updating the model. Blocks
with constant sample time are colored magenta.

For example, in this model, as sample time colors show, both the Constant and
Gain blocks have constant sample time.

; K Ts
=1
Constant Gain Discrate-Time Soope
Sample Time = inf Sample Time = -1 Integratar

i

Inline Parameterz= an

The Gain block has constant sample time because it inherits its sample time
from the Constant block and all of the model’s parameters are inlined, i.e.,
nontunable.

Note The Simulink block library includes a few blocks, e.g., the S-Function,
Level-2 M-File S-Function, Rate Transition, and Model block, whose ports can
produce outputs at different sample rates. It is possible for some of the ports of
such blocks to inherit a constant sample time. The ports with constant sample
time produce output only once, at the beginning of the simulation. The other
ports produce outputs at their sample rates.

How Simulink Treats Blocks with Infinite Sample Times and Tunable
Parameters

A block that has tunable parameters cannot have constant sample time even if
its sample time is specified to be infinite. This is because the fact that a block
has one or more tunable parameters means that you can change the values of
its parameters during simulation and hence the value of its outputs. In this
case, Simulink uses sample time propagation (see “Sample Time Propagation”
on page 2-35) to determine the block’s actual sample time.

For example, consider the following model.
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In this example, although the Constant block’s sample time is specified to be
infinite, it cannot have constant sample time because the inlined parameters
option is off for this model and therefore the block’s Constant value parameter
is tunable. Since the Constant block’s output can change during the simulation,
Simulink has to determine a sample time for the block that ensures accurate
simulation results. It does this by treating the Constant block’s sample time as
inherited and using sample time propagation to determine its sample time. The
first nonvirtual block in the diagram branch to which the Constant block is
connected is the Discrete-Time Integrator block. As a result, the block inherits
its sample time (1 sec) via back propagation from the Discrete-Time Integrator
block.

Mixed Continuous and Discrete Systems

Mixed continuous and discrete systems are composed of both sampled and
continuous blocks. Such systems can be simulated using any of the integration
methods, although certain methods are more efficient and accurate than
others. For most mixed continuous and discrete systems, the Runge-Kutta
variable-step methods, ode23 and ode45, are superior to the other methods in
terms of efficiency and accuracy. Because of discontinuities associated with the
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sample and hold of the discrete blocks, the ode15s and ode113 methods are not
recommended for mixed continuous and discrete systems.
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Simulink Basics

The following sections explain how to perform basic Simulink tasks.

Starting Simulink (p. 3-2)

Opening Models (p. 3-4)

Simulink Editor (p. 3-6)

Saving a Model (p. 3-9)

Printing a Block Diagram (p. 3-13)
Generating a Model Report (p. 3-17)

Summary of Mouse and Keyboard
Actions (p. 3-20)

Ending a Simulink Session (p. 3-23)

How to start Simulink.

How to open a Simulink model.
Overview of the Simulink Editor.

How to save a Simulink model to disk.
How to print a Simulink block diagram.

How to generate an HTML report on a model’s structure
and content.

Lists key combinations and mouse actions that you can
use to execute Simulink commands.

How to end a Simulink session.
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Starting Simulink

To start Simulink, you must first start MATLAB. Consult your MATLAB
documentation for more information. You can then start Simulink in two ways:

¢ Click the Simulink icon EI on the MATLAB toolbar.
¢ Enter the simulink command at the MATLAB prompt.

On Microsoft Windows platforms, starting Simulink displays the Simulink
Library Browser.

[ simulink Library Browser E B =] o7
File Edit View Help
O 4 i

Commonly Used Blocks: simulink/Commonly
Used Blocks

B Simulink

2] Commanly Used Blocks
2| Continuous

| Discontinuities

| Discrete

£l

El
g8
22
i

Continuous

2 Logic and Bit Operations Discontinuities
2] Lookup Tables
2] Math Operations Discrete

il

2| Model Verification

i :m‘ ide Uites &l Losic B gperaions
orts & Subsystems =
2] Signal Attributes

yeftuh|  Lookup Tables

2| Signal Rauting

2| Sinks

| Sources

2| User-Defined Functions
| Additional Math & Discrete
W Real-Time Workshop

o
L

Math Dperations

B

Model Yerification

Bl Simink Extras Mise | Modelwide Ulitiss
B Statefion =
[ F
qu| Pors b Subsystems ]
Ready 4

The Library Browser displays a tree-structured view of the Simulink block
libraries installed on your system. You can build models by copying blocks from
the Library Browser into a model window (see “Editing Blocks” on page 5-4).

3-2



Starting Simulink

On UNIX platforms, starting Simulink displays the Simulink block library

window.

E!Lihrary: simulink

File Edit WYiew Formatb Help

Toolboxes

uzed blocks

Blocksets & commaonly Additional Math
& Dizcrete

Copyright (c) 19902004
The MathWoarks, Inc.
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Routing Attributes
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- = y=fuf y=fitu}) @ Misc
- X <= @ ]
Math Logic and Bit Lookup Uzar-Defined Model For= & Mode -\Wide
Dperations Dperations Tablkes Functions Varification Subsystams Ltilities
Simulink Block Library 6.0
Demos

The Simulink library window displays icons representing the block libraries
that come with Simulink. You can create models by copying blocks from the
library into a model window.

Note On Windows, you can display the Simulink library window by

right-clicking the Simulink node in the Library Browser window.
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Opening Models

To edit an existing model diagram, either

® Click the Open button on the Library Browser’s toolbar (Windows only) or
select Open from the Simulink library window’s File menu and then choose
or enter the file name for the model to edit.

¢ Enter the name of the model (without the .md1 extension) in the MATLAB
Command Window. The model must be in the current directory or on the
path.

Opening Models with Different Character Encodings

If you open a model created in a MATLAB session configured to support one
character set encoding, for example, Shift_JIS, in a MATLAB session
configured to support another character encoding, for example, US_ASCII,
Simulink displays a warning or an error message, depending on whether it can
or cannot encode the model, using the current character encoding, respectively.
The warning or error message specifies the encoding of the current session and
the encoding used to create the model. To avoid corrupting the model (see
“Saving Models with Different Character Encodings” on page 3-9) and ensure
correct display of the model’s text, you should

1 Close all models open in the current session.

2 Use the s1CharacterEncoding command to change the character encoding
of the current MATLAB session to that of the model as specified in the
warning message.

3 Reopen the model.

You can now safely edit and save the model.

Avoiding Initial Model Open Delay

You may notice that the first model that you open in a MATLAB session takes
longer to open than do subsequent models. This is because to reduce its own
startup time and to avoid unnecessary consumption of your system’s memory,
MATLAB does not load Simulink into memory until the first time you open a
Simulink model. You can cause MATLAB to load Simulink at MATLAB



Opening Models

startup, and thus avoid the initial model opening delay, using either the -r
MATLAB command line option or your MATLAB startup.m file to run either
load_simulink (loads Simulink) or simulink (loads Simulink and opens the
Simulink Library browser) at MATLAB startup. For example, to load Simulink
at MATLAB startup on Microsoft Windows systems, create a desktop shortcut
with the following target:

<matlabroot>\bin\win32\matlab.exe -r load_simulink

Similarly, the following command loads Simulink at MATLAB startup on
UNIX systems:

matlab -r load_simulink
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Simulink Editor

When you open a Simulink model or library, Simulink displays the model or
library in an instance of the Simulink Editor.

1 g [=]
File Edit Wiew Simulation Format Tools Help <—Menu B(]r

DIEE&| L2l oy sfm |vom - RS REE T ® <«—— Toolhar

van der Pol Equation
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: Double-olisk
(Double-slisk on the " for more info) °h”5':f‘;"

Simulink Help

To start and stop the simulation, use the "
zelection in the "Simulation” pull-down menu

Ready [100% [ode45 /| «——— Status Bar

Editor Components
The Simulink Editor includes the following components.

Menu Bar

The Simulink menu bar contains commands for creating, editing, viewing,

printing, and simulating models. The menu commands apply to the model

displayed in the editor. See Chapter 4, “Creating a Model” and Chapter 10,
“Running Simulations” for more information.

Toolbar

The toolbar allows you to execute Simulink’s most frequently used Simulink
commands with a click of a mouse button. For example, to open a Simulink
model, click the open folder icon on the toolbar. Letting the mouse cursor hover
over a toolbar button or control causes a tooltip to appear. The tooltip describes
the purpose of the button or control. You can hide the toolbar by clearing the
Toolbar option on the Simulink View menu.
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Canvas

The canvas displays the model’s block diagram. The canvas allows you to edit
the block diagram. You can use your system’s mouse and keyboard to create
and connect blocks, selelect and move blocks, edit block labels, display block
dialog boxes, and so on. See Chapter 5, “Working with Blocks” for more
information.

Context Menus

Simulink displays a context-sensitive menu when you click the right mouse
button over the canvas. The contents of the menu depend on whether a block is
selected. If a block is selected, the menu displays commands that apply only to
the selected block. If no block is selected, the menu displays commands that
apply to a model or library as a whole.

Status Bar

The status bar appears only in the Windows version of the Simulink Editor.
When a simulation is running, the status bar displays the status of the
simulation, including the current simulation time and the name of the current
solver. You can display or hide the status bar by selecting or clearing the
Status Bar option on the Simulink View menu.

Undoing a Command

You can cancel the effects of up to 101 consecutive operations by choosing Undo
from the Edit menu. You can undo these operations:

® Adding, deleting, or moving a block

¢ Adding, deleting, or moving a line

® Adding, deleting, or moving a model annotation

¢ Editing a block name

¢ Creating a subsystem (see “Undoing Subsystem Creation” on page 4-23 for
more information)

You can reverse the effects of an Undo command by choosing Redo from the
Edit menu.
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Zooming Block Diagrams

Simulink allows you to enlarge or shrink the view of the block diagram in the
current Simulink window. To zoom a view:

® Select Zoom In from the View menu (or type r) to enlarge the view.
® Select Zoom Out from the View menu (or type v) to shrink the view.

® Select Fit System to View from the View menu (or press the space bar) to
fit the diagram to the view.

¢ Select Normal from the View menu to view the diagram at actual size.

By default, Simulink fits a block diagram to view when you open the diagram
either in the model browser’s content pane or in a separate window. If you
change a diagram’s zoom setting, Simulink saves the setting when you close
the diagram and restores the setting the next time you open the diagram. If you
want to restore the default behavior, choose Fit System to View from the View
menu the next time you open the diagram.

Panning Block Diagrams

You can use the mouse to pan model diagrams that are too large to fit in the
model editor’s window. To do this, position the mouse over the diagram and
hold down the left mouse button and the P or Q key on the keyboard. Moving
the mouse now pans the model diagram in the editor window.

3-8



Saving a Model

Saving a Model

You can save a model by choosing either the Save or Save As command from
the File menu. Simulink saves the model by generating a specially formatted
file called the model file (with the .md1 extension) that contains the block
diagram and block properties.

If you are saving a model for the first time, use the Save command to provide
aname and location for the model file. Model file names must start with a letter
and can contain no more than 63 letters, numbers, and underscores. The file
name must not be the same as that of a MATLAB command.

If you are saving a model whose model file was previously saved, use the Save
command to replace the file’s contents or the Save As command to save the
model with a new name or location. You can also use the Save As command to
save the model in a format compatible with previous releases of Simulink (see
“Saving a Model in Earlier Formats” on page 3-10).

Simulink follows this procedure while saving a model:
1 Ifthe mdl file for the model already exists, it is renamed as a temporary file.

2 Simulink executes all block PreSaveFcn callback routines, then executes the
block diagram’s PreSaveFcn callback routine.

3 Simulink writes the model file to a new file using the same name and an
extension of mdl.

4 Simulink executes all block PostSaveFcn callback routines, then executes
the block diagram’s PostSaveFcn callback routine.

5 Simulink deletes the temporary file.

If an error occurs during this process, Simulink renames the temporary file to
the name of the original model file, writes the current version of the model to a
file with an .err extension, and issues an error message. Simulink performs
steps 2 through 4 even if an error occurs in an earlier step.

Saving Models with Different Character Encodings

When Simulink saves a model, it uses the character encoding in effect when the
model was created (the original encoding) to encode the text stored in the
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model’s .md1 file, regardless of the character encoding in effect when the model
is saved. This can lead to model corruption if you save a model whose original
encoding differs from encoding currently in effect in the MATLAB session.

For example, it’s possible you could have introduced characters that cannot be
represented in the model’s original encoding. If this is the case, Simulink saves
the model as model.err where model is the model’s name, leaving the original
model file unchanged. Simulink also displays an error message that specifies
the line and column number of the first unrepresentable character. To recover
from this error without losing all the changes you’ve made to the model in the
current session, use the following procedure. First, use a text editor to find the
character in the .err file at the position specified by the save error message.
Then, returning to Simulink, find and delete the corresponding character in
the open model and resave the model . Repeat this process until you are able to
save the model without error.

It’s possible that your model’s original encoding can represent all the text
changes that you’ve made in the current sesssion, albeit incorrectly. For
example, suppose you open a model whose original encoding is A in a MATLAB
session whose current encoding is B. Further, suppose you edit the model to
include a character that has different encodings in A and B and then save the
model. For example, suppose that the encoding for x in B is the same as the
coding for y in A and you insert x in the model while B is in effect, save the
model, and then reopen the model with A in effect. In this scenario, Simulink
will display x as y. To alert you to the possibility of such corruptions, Simulink
displays a warning message when you save a model and the current and
original encoding differ but the original encoding can encode, possibly
incorrectly, all the characters to be saved in the model file.

Saving a Model in Earlier Formats

The Save As command allows you to save a model created with the latest
version of Simulink in formats used by earlier versions of Simulink, including
Simulink 3 (Release 11), Simulink 4 (Release 12), and Simulink 4.1 (Release
12.1). You might want to do this, for example, if you need to make a model
available to colleagues who have access only to one of these earlier versions of
Simulink.

To save a model in earlier format:
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1 Select Save As from the Simulink File menu.

Simulink displays the Save As dialog box.

21|

Save in: I@ simgeneral j - = EB-

ja dblpendz, mdl lights.mdl thermo.
bangbang, mdl hardstop,mdl onecart.mdl toilet, me
bounce.mdl byl mdl penddemnao, mdl wdp.md|
countersdema,md| heedeyl4,mdl simppend. md|
dblcarttmdl Frydlib.mdl simquat.mdl
dblpend1, mdl hydrod.mdl slprimes.mdl

1

File name: |hydc:_l,ll.mdl

Simu 1 Models [~ mdl
Simulink, 4/812 Models [*.mdl)
Simulink 4.1/H12.1 Models [*.mdl

2 Select a format from the Save as type list on the dialog box.

3 Click the Save button.

When saving a model in an earlier version’s format, Simulink saves the model
in that format regardless of whether the model contains blocks and features
that were introduced after that version. If the model does contain blocks or use
features that postdate the earlier version, the model might not give correct
results when run by the earlier version. For example, matrix and frame signals
do not work in Release 11, because Release 11 does not have matrix and frame
support. Similarly, models that contain unconditionally executed subsystems
marked “Treat as atomic unit” might produce different results in Release 11,
because Release 11 does not support unconditionally executed atomic
subsystems.

The command converts blocks that postdate the earlier version into empty
masked subsystem blocks colored yellow. For example, post-Release 11 blocks
include

¢ Lookup Table (n-D)
® Assertion

e Rate Transition
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® PreLookup Index Search

¢ Interpolation (n-D)

¢ Direct Lookup Table (n-D)

® Polynomial

® Matrix Concatenation

® Signal Specification

® Bus Creator

e If, Whilelterator, Forlterator, Assignment
® SwitchCase

¢ Bitwise Logical Operator

Post-Release 11 blocks from Simulink blocksets appear as unlinked blocks.
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Printing a Block Diagram

You can print a block diagram by selecting Print from the File menu (on a
Microsoft Windows system) or by using the print command in the MATLAB
Command Window (on all platforms).

On a Microsoft Windows system, the Print menu item prints the block diagram
in the current window.

Print Dialog Box

When you select the Print menu item, the Print dialog box appears. The Print
dialog box enables you to selectively print systems within your model. Using
the dialog box, you can print

® The current system only

® The current system and all systems above it in the model hierarchy

¢ The current system and all systems below it in the model hierarchy, with the
option of looking into the contents of masked and library blocks

e All systems in the model, with the option of looking into the contents of
masked and library blocks

® An overlay frame on each diagram
The portion of the Print dialog box that supports selective printing is similar

on supported platforms. This figure shows how it looks on a Microsoft Windows
system. In this figure, only the current system is to be printed.

r— Options
o . . ~
Current sy{:&m Current system Current system All zystems
. and above and below
L LI S .
[ Include Print Log 7| ook under mask dislog
7| Expand unigue [Granlinks
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When you select either the Current system and below or All systems option,
two check boxes become enabled. In this figure, All systems is selected.

— Optionz

. . . =

Current system Current system Current system Al zystems

. and ab:cwe and be:-low
L L S .
™ Include Print Log ™ Look under mask dialog

[ Expand unique library links

™ Frame: ID:WE\IO0Ibm-:'\simulink'\simulink'\sldefaultfram I

ak. I Cancel |

Selecting the Look Under Mask Dialog check box prints the contents of
masked subsystems when encountered at or below the level of the current
block. When you are printing all systems, the top-level system is considered the
current block, so Simulink looks under any masked blocks encountered.

Selecting the Expand Unique Library Links check box prints the contents of
library blocks when those blocks are systems. Only one copy is printed

regardless of how many copies of the block are contained in the model. For more
information about libraries, see “Working with Block Libraries” on page 5-32.

The print log lists the blocks and systems printed. To print the print log, select
the Include Print Log check box.

Selecting the Frame check box prints a title block frame on each diagram.
Enter the path to the title block frame in the adjacent edit box. You can create
a customized title block frame, using the MATLAB frame editor. See
frameedit in the online MATLAB reference for information on using the frame
editor to create title block frames.

Print Command
The format of the print command is

print -ssys -device filename



Printing a Block Diagram

sys is the name of the system to be printed. The system name must be preceded
by the s switch identifier and is the only required argument. sys must be open
or must have been open during the current session. If the system name
contains spaces or takes more than one line, you need to specify the name as a
string. See the examples below.

device specifies a device type. For a list and description of device types, see the
documentation for the MATLAB print function.

filename is the PostScript file to which the output is saved. If filename exists,
it is replaced. If filename does not include an extension, an appropriate one is
appended.

For example, this command prints a system named untitled.

print -suntitled

This command prints the contents of a subsystem named Sub1 in the current
system.

print -sSub1

This command prints the contents of a subsystem named Requisite Friction.
print (['-sRequisite Friction'])
The next example prints a system named Friction Model, a subsystem whose

name appears on two lines. The first command assigns the newline character
to a variable; the second prints the system.

cr = sprintf('\n');
print (['-sFriction' cr 'Model'])
To print the currently selected subsystem, enter

print(['-s', gcb])

Specifying Paper Size and Orientation

Simulink lets you specify the type and orientation of the paper used to print a
model diagram. You can do this on all platforms by setting the model’s
PaperType and PaperOrientation properties, respectively (see “Model and
Block Parameters” in the online documentation), using the set_param
command. You can set the paper orientation alone, using the MATLAB orient
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command. On Windows, the Print and Printer Setup dialog boxes let you set
the page type and orientation properties as well.

Positioning and Sizing a Diagram

You can use a model’s PaperPositionMode and PaperPosition parameters to
position and size the model’s diagram on the printed page. The value of the
PaperPosition parameter is a vector of form [left bottom width height].
The first two elements specify the bottom left corner of a rectangular area on
the page, measured from the page’s bottom left corner. The last two elements
specify the width and height of the rectangle. When the model’s
PaperPositionMode is manual, Simulink positions (and scales, if necessary)
the model’s diagram to fit inside the specified print rectangle. For example, the
following commands

vdp

set_param('vdp', 'PaperType', 'usletter')
set_param('vdp', 'PaperOrientation', 'landscape')
set_param('vdp', 'PaperPositionMode', ‘'manual')
set_param('vdp', 'PaperPosition', [0.5 0.5 4 4])
print -svdp

print the block diagram of the vdp sample model in the lower left corner of a
U.S. letter-size page in landscape orientation.

If PaperPositionMode is auto, Simulink centers the model diagram on the
printed page, scaling the diagram, if necessary, to fit the page.
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Generating a Model Report

A Simulink model report is an HTML document that describes a model’s
structure and content. The report includes block diagrams of the model and its

subsystems and the settings of its block parameters.

To generate a report for the current model:
1 Select Print details from the model’s File menu.

The Print Details dialog box appears.

<) Print Details - fuelsys ; I [ 3

File lacationfnaming options
Directary & Current (pwd)
& Temparary tempdin)

" Cther: IlIEI attoastenR1 Zperfectihintwiniz

[ Incrernent filenarme to prevent ovenwriting old files

Syst tting options

1 " Currentand above € Currentand below  © Entire model

Frint I Cancel |

The dialog box allows you to select various report options (see “Model Report

Options” on page 3-18).
2 Select the desired report options on the dialog box.

3 Select Print.

Simulink generates the HTML report and displays the in your system’s default

HTML browser.
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While generating the report, Simulink displays status messages on a messages
pane that replaces the options pane on the Print Details dialog box.

<} Print Details - fuelsys : g =10l |
|3) Impartant messages {running a loop) LI
Looping on madel "fuelsys”
Looping on machine "fuelsys"
Looping on systerm "fuelsys”
Could not find any "Block” abjects for summary tahle.

You can select the detail level of the messages from the list at the top of the
messages pane. When the report generation process begins, the Print button
on the Print Details dialog box changes to a Stop button. Clicking this button
terminates the report generation. When the report generation process finishes,
the Stop button changes to an Options button. Clicking this button redisplays
the report generation options, allowing you to generate another report without
having to reopen the Print Details dialog box.

Model Report Options

The Print Details dialog box allows you to select the following report options.

Directory

The directory where Simulink stores the HTML report that it generates. The
options include your system’s temporary directory (the default), your system’s

current directory, or another directory whose path you specify in the adjacent
edit field.

Increment filename to prevent overwriting old files

Creates a unique report file name each time you generate a report for the same
model in the current session. This preserves each report.



Generating a Model Report

Current object
Include only the currently selected object in the report.

Current and above

Include the current object and all levels of the model above the current object
in the report.

Current and below
Include the current object and all levels below the current object in the report.

Entire model
Include the entire model in the report.

Look under mask dialog
Include the contents of masked subsystems in the report.

Expand unique library links

Include the contents of library blocks that are subsystems. The report includes
a library subsystem only once even if it occurs in more than one place in the
model.
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Summary of Mouse and Keyboard Actions

These tables summarize the use of the mouse and keyboard to manipulate
blocks, lines, and signal labels. LMB means press the left mouse button; CMB,
the center mouse button; and RMB, the right mouse button.

Manipulating Blocks
The following table lists mouse and keyboard actions that apply to blocks.

Task Microsoft Windows UNIX

Select one block LMB LMB

Select multiple Shift + LMB Shift + LMB; or CMB
blocks alone

Copy block from Drag block Drag block

another window

Move block Drag block Drag block

Duplicate block Ctrl + LMB and drag; Ctrl + LMB and drag;

Connect blocks

Disconnect block

Open selected
subsystem

Go to parent of
selected subsystem

or RMB and drag
LMB
Shift + drag block

Enter

Esc

or RMB and drag
LMB

Shift + drag block; or
CMB and drag

Return

Esc
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Manipulating Lines
The following table lists mouse and keyboard actions that apply to lines.

Task

Microsoft Windows

UNIX

Select one line

Select multiple lines

Draw branch line

Route lines around
blocks

Move line segment
Move vertex

Create line
segments

LMB
Shift + LMB

Ctrl + drag line; or
RMB and drag line

Shift + draw line
segments

Drag segment
Drag vertex

Shift + drag line

LMB

Shift + LMB; or CMB
alone

Ctrl + drag line; or
RMB + drag line

Shift + draw line
segments; or CMB and
draw segments

Drag segment
Drag vertex

Shift + drag line; or
CMB + drag line

Manipulating Signal Labels
The next table lists mouse and keyboard actions that apply to signal labels.

Action

Microsoft Windows

UNIX

Create signal label

Copy signal label
Move signal label
Edit signal label

Delete signal label

Double-click line, then
enter label

Ctrl + drag label
Drag label
Click in label, then edit

Shift + click label, then
press Delete

Double-click line, then
enter label

Ctrl + drag label
Drag label
Click in label, then edit

Shift + click label, then
press Delete
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Manipulating Annotations
The next table lists mouse and keyboard actions that apply to annotations.

Action

Microsoft Windows

UNIX

Create annotation

Copy annotation
Move annotation
Edit annotation

Delete annotation

Double-click in
diagram, then enter
text

Ctrl + drag label
Drag label
Click in text, then edit

Shift + select
annotation, then press
Delete

Double-click in
diagram, then enter
text

Ctrl + drag label
Drag label
Click in text, then edit

Shift + select
annotation, then press
Delete
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Ending a Simulink Session

Terminate a Simulink session by closing all Simulink windows.

Terminate a MATLAB session by choosing one of these commands from the
File menu:

® On a Microsoft Windows system: Exit MATLAB
® On a UNIX system: Quit MATLAB
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Creating a Model

The following sections explain how to perform tasks required to create Simulink models.

Creating a New Model (p. 4-2)
Selecting Objects (p. 4-3)

Specifying Block Diagram Colors
(p. 4-5)

Connecting Blocks (p. 4-10)
Annotating Diagrams (p. 4-17)
Creating Subsystems (p. 4-21)

Creating Conditionally Executed
Subsystems (p. 4-27)

Referencing Models (p. 4-44)

Modeling with Control Flow Blocks
(p. 4-59)

Using Callback Functions (p. 4-70)

Working with Model Workspaces
(p. 4-76)

Working with Data Stores (p. 4-83)
The Model Advisor (p. 4-89)

Managing Model Versions (p. 4-92)

Model Discretizer (p. 4-102)

How to create a new model.
How to select objects in a model.

How to specify the colors of blocks, lines, and annotations
and the background of the diagram.

How to draw connections between blocks.
How to add annotations to a block diagram.
How to create subsystems.

How to create subsystems that are executed only when
specified events occur or conditions are satisfied.

How to include one model as a block in another model.

How to use control flow blocks to model control logic.

How to use callback routines to customize a model.

How to modify, save, and reload a model’s private
workspace.

How to create and access data stores.

How to use the Model Advisor to configure a model for
efficient simulation and code generation.

How to use version control systems to manage and track
development of Simulink models.

How to create a discrete model from a continuous model.
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Creating a New Model

To create a new model, click the New button on the Library Browser’s toolbar
(Windows only) or choose New from the library window’s File menu and select
Model. You can move the window as you do other windows. Chapter 1, “Getting
Started” describes how to build a simple model. “Modeling Equations” on
page 8-2 describes how to build systems that model equations.



Selecting Obijects

Selecting Obijects

Many model building actions, such as copying a block or deleting a line, require
that you first select one or more blocks and lines (objects).

Selecting One Object

To select an object, click it. Small black square “handles” appear at the corners
of a selected block and near the end points of a selected line. For example, the
figure below shows a selected Sine Wave block and a selected line.

R ——

Sine Wawve

When you select an object by clicking it, any other selected objects are
deselected.

Selecting More Than One Object

You can select more than one object either by selecting objects one at a time, by
selecting objects located near each other using a bounding box, or by selecting
the entire model.

Selecting Multiple Objects One at a Time

To select more than one object by selecting each object individually, hold down
the Shift key and click each object to be selected. To deselect a selected object,
click the object again while holding down the Shift key.

Selecting Multiple Objects Using a Bounding Box

An easy way to select more than one object in the same area of the window is
to draw a bounding box around the objects:

1 Define the starting corner of a bounding box by positioning the pointer at
one corner of the box, then pressing and holding down the mouse button.
Notice the shape of the cursor.

_.|_

]
7]

Sine Wawve
Scope
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2 Drag the pointer to the opposite corner of the box. A dotted rectangle
encloses the selected blocks and lines.

Sine Wawve
Scope

3 Release the mouse button. All blocks and lines at least partially enclosed by
the bounding box are selected.

F—]
]

Sine Wawve =
Scope

Selecting the Entire Model

To select all objects in the active window, choose Select All from the Edit
menu. You cannot create a subsystem by selecting blocks and lines in this way.
For more information, see “Creating Subsystems” on page 4-21.

4-4



Specifying Block Diagram Colors

Specifying Block Diagram Colors

Simulink allows you to specify the foreground and background colors of any
block or annotation in a diagram, as well as the diagram’s background color. To
set the background color of a block diagram, select Sereen color from the
Simulink Format menu. To set the background color of a block or annotation
or group of such items, first select the item or items. Then select Background
color from the Simulink Format menu. To set the foreground color of a block
or annotation, first select the item. Then select Foreground color from the
Simulink Format menu.

In all cases, Simulink displays a menu of color choices. Choose the desired color
from the menu. If you select a color other than Custom, Simulink changes the
background or foreground color of the diagram or diagram element to the
selected color.

Choosing a Custom Color

If you choose Custom, Simulink displays the Simulink Choose Custom Color
dialog box.

Basic colors:

J 55 ¢

il il il |

I

I

L
[l .

LCustom colors:

N o o
N o

Define Custom Colors »» |

Cancel |

The dialog box displays a palette of basic colors and a palette of custom colors
that you previously defined. If you have not previously created any custom
colors, the custom color palette is all white. To choose a color from either
palette, click the color, and then click the OK button.
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Defining a Custom Color

To define a custom color, click the Define Custom Colors button on the
Choose Custom Color dialog box. The dialog box expands to display a custom
color definer.

Choose Custom Color EHE

Basic colors:

| Hue-saturation cursor

L Uil |
IR
e 0 L
WO Wl el
LCustom colors: |_ .
||: F F F F F F F Hug:lﬁ Bed:ﬁ uminescence cursor
ﬁat:lm Green: |205
Wefife Eustonm Calars >3 | ColarlS glid Lurr: IE Blue: W
Cancel | Add ta Custom Colors |

The color definer allows you to specify a custom color by

¢ Entering the red, green, and blue components of the color as values between
0 (darkest) and 255 (brightest)

¢ Entering hue, saturation, and luminescence components of the color as
values in the range 0 to 255

® Moving the hue-saturation cursor to select the hue and saturation of the
desired color and the luminescence cursor to select the luminescence of the
desired color

The color that you have defined in any of these ways appears in the

Color | Solid box. To redefine a color in the Custom colors palette, select the
color and define a new color, using the color definer. Then click the Add to
Custom Colors button on the color definer.

Specifying Colors Programmatically

You can use the set_param command at the MATLAB command line or in an
M-file program to set parameters that determine the background color of a
diagram and the background color and foreground color of diagram elements.



Specifying Block Diagram Colors

The following table summarizes the parameters that control block diagram
colors.

Parameter Determines

ScreenColor Background color of block diagram
BackgroundColor Background color of blocks and annotations
ForegroundColor Foreground color of blocks and annotations

You can set these parameters to any of the following values:

® 'plack’', 'white', 'red’, 'green', 'blue’, 'cyan’', 'magenta’, 'yellow’,
‘gray', 'lightBlue', 'orange’', 'darkGreen’

®'[r,g,b]"
where r, g, and b are the red, green, and blue components of the color
normalized to the range 0.0 to 1.0.

For example, the following command sets the background color of the currently
selected system or subsystem to a light green color:

set_param(gcs, 'ScreenColor', '[0.3, 0.9, 0.5]")

Displaying Sample Time Colors

Simulink can color code the blocks and lines in your model to indicate the
sample rates at which the blocks operate.

Color Use

Black Continuous blocks

Magenta Constant blocks

Yellow Hybrid (subsystems grouping blocks, Mux or Demux blocks

grouping signals with varying sample times, Data Store
Memory blocks updated and read by different tasks)

Red Fastest discrete sample time

4-7



4 Creating a Model

4-8

Color Use
Green Second fastest discrete sample time
Blue Third fastest discrete sample time

Light Blue Fourth fastest discrete sample time

Dark Green  Fifth fastest discrete sample time

Orange Sixth fastest discrete sample time
Cyan Blocks in triggered subsystems
Gray Fixed in minor step

To enable the sample time colors feature, select Sample Time Colors from the
Format menu.

Simulink does not automatically recolor the model with each change you make
to it, so you must select Update Diagram from the Edit menu to explicitly
update the model coloration. To return to your original coloring, disable sample
time coloration by again choosing Sample Time Colors.

The color that Simulink assigns to each block depends on its sample time
relative to other sample times in the model. This means that the same sample
time may be assigned different colors in a toplevel model and in the models that
it references (see “Referencing Models” on page 4-44). For example, suppose
that a model defines three sample times: 1, 2, and 3. Further, suppose that it
references a model that defines two sample times: 2 and 3. In this case, blocks
operating at the 2 sample rate appear as green in the toplevel model and as red
in the referenced model.

It is important to note that Mux and Demux blocks are simply grouping
operators; signals passing through them retain their timing information. For
this reason, the lines emanating from a Demux block can have different colors
if they are driven by sources having different sample times. In this case, the
Mux and Demux blocks are color coded as hybrids (yellow) to indicate that they
handle signals with multiple rates.

Similarly, Subsystem blocks that contain blocks with differing sample times
are also colored as hybrids, because there is no single rate associated with
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them. If all the blocks within a subsystem run at a single rate, the Subsystem
block is colored according to that rate.
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Connecting Blocks

Simulink block diagrams use lines to represent pathways for signals among
blocks in a model (see “Annotating Diagrams” on page 4-17 for information on
signals). Simulink can connect blocks for you or you can connect the blocks
yourself by drawing lines from their output ports to their input ports.

Automatically Connecting Blocks

You can command Simulink to connect blocks automatically. This eliminates
the need for you to draw the connecting lines yourself. When connecting blocks,
Simulink routes lines around intervening blocks to avoid cluttering the
diagram.

Connecting Two Blocks
To autoconnect two blocks:

1 Select the source block.

2 Hold down Ctrl and left-click the destination block.

Simulink connects the source block to the destination block, routing the line
around intervening blocks if necessary.




Connecting Blocks

When connecting two blocks, Simulink draws as many connections as possible
between the two blocks as illustrated in the following example.

thtl L] L]
[ -
ot s " "
SubBystem

FubSysten

Before autoconnect After autoconnect

Connecting Groups of Blocks

Simulink can connect a group of source blocks to a destination block or a source
block to a group of destination blocks.

To connect a group of source blocks to a destination block:

1 Select the source blocks.

Sine Wave
Sine Wavel

Sine Wave §%
Sine Wavel [=]

To connect a source block to a group of destination blocks:

1 Select the destination blocks.
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2 Hold down Ctrl and left-click the source block.

Manually Connecting Blocks

Simulink allows you to draw lines manually between blocks or between lines
and blocks. You might want to do this if you need to control the path of the line
or to create a branch line.

Drawing a Line Between Blocks
To connect the output port of one block to the input port of another block:

1 Position the cursor over the first block’s output port. It is not necessary to
position the cursor precisely on the port. The cursor shape changes to
crosshairs.

G >

Constant & ain

2 Press and hold down the mouse button.

3 Drag the pointer to the second block’s input port. You can position the cursor
on or near the port or in the block. If you position the cursor in the block, the
line is connected to the closest input port. The cursor shape changes to
double crosshairs.

[1—H>

Constant G ain

4 Release the mouse button. Simulink replaces the port symbols by a
connecting line with an arrow showing the direction of the signal flow. You
can create lines either from output to input, or from input to output. The
arrow is drawn at the appropriate input port, and the signal is the same.
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P

Constant & ain

Simulink draws connecting lines using horizontal and vertical line segments.
To draw a diagonal line, hold down the Shift key while drawing the line.

Drawing a Branch Line

A branch line is a line that starts from an existing line and carries its signal to
the input port of a block. Both the existing line and the branch line carry the

same signal. Using branch lines enables you to cause one signal to be carried

to more than one block.

In this example, the output of the Product block goes to both the Scope block
and the To Workspace block.

=
Product
radu Scope
To Madspace

To add a branch line, follow these steps:
1 Position the pointer on the line where you want the branch line to start.
2 While holding down the Ctrl key, press and hold down the left mouse button.

3 Drag the pointer to the input port of the target block, then release the mouse
button and the Ctrl key.

You can also use the right mouse button instead of holding down the left mouse
button and the Ctrl key.

Drawing a Line Segment

You might want to draw a line with segments exactly where you want them
instead of where Simulink draws them. Or you might want to draw a line
before you copy the block to which the line is connected. You can do either by
drawing line segments.
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To draw a line segment, you draw a line that ends in an unoccupied area of the
diagram. An arrow appears on the unconnected end of the line. To add another
line segment, position the cursor over the end of the segment and draw another
segment. Simulink draws the segments as horizontal and vertical lines. To

draw diagonal line segments, hold down the Shift key while you draw the lines.

Moving a Line Segment
To move a line segment, follow these steps:

1 Position the pointer on the segment you want to move.

[
Sine Wave Product

Constant

2 Press and hold down the left mouse button.

Sine Wave

K,

Constant

‘:‘_' FProduct

3 Drag the pointer to the desired location.

- =
[ . <
Sine Miave Froduct

Anng

T

Constant
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4 Release the mouse button.

Sine Wave

E,

Constant

Froduct

To move the segment connected to an input port, position the pointer over the
port and drag the end of the segment to the new location. You cannot move the
segment connected to an output port.

Moving a Line Vertex
To move a vertex of a line, follow these steps:

1 Position the pointer on the vertex, then press and hold down the mouse
button. The cursor changes to a circle that encloses the vertex.

[

Constant

Scope

2 Drag the pointer to the desired location.

=
\\*9”

Constant Scape

3 Release the mouse button.

‘* —
Constant } Scape

Inserting Blocks in a Line

You can insert a block in a line by dropping the block on the line. Simulink
inserts the block for you at the point where you drop the block. The block that
you insert can have only one input and one output.
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To insert a block in a line:

1 Position the pointer over the block and press the left mouse button.

=
¥
i

1 T
[ ]
Gizin
[ ‘ =
1%/
o p—

3 Release the mouse button to drop the block on the line. Simulink inserts the
block where you dropped it.

N . —

Disconnecting Blocks

To disconnect a block from its connecting lines, hold down the Shift key, then
drag the block to a new location.
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Annotating Diagrams

Annotations provide textual information about a model. You can add an
annotation to any unoccupied area of your block diagram.

This sample model .
shows a constant signal Annotations
heing input to a Scope.

[1] "
Constant / -
This block generates This block displays its input

a.constantsignal graphically in a window that
with 2 value of 1. looks like an oscilloscope.

To create a model annotation, double-click an unoccupied area of the block
diagram. A small rectangle appears and the cursor changes to an insertion
point. Start typing the annotation contents. Each line is centered within the
rectangle that surrounds the annotation.

To move an annotation, drag it to a new location.

To edit an annotation, select it:
® To replace the annotation, click the annotation, then double-click or drag the
cursor to select it. Then, enter the new annotation.

® To insert characters, click between two characters to position the insertion
point, then insert text.

® To replace characters, drag the mouse to select a range of text to replace,
then enter the new text.

To delete an annotation, hold down the Shift key while you select the
annotation, then press the Delete or Backspace key.

To change the font of all or part of an annotation, select the text in the
annotation you want to change, then choose Font from the Format menu.
Select a font and size from the dialog box.

To change the text alignment (e.g., left, center, or right) of the annotation,
select the annotation and choose Text Alignment from the model window’s
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Format or context menu. Then choose one of the alignment options (e.g.,
Center) from the Text Alignment submenu.

Using TeX Formatting Commands in Annotations

You can use TeX formatting commands to include mathematical and other
symbols and Greek letters in block diagram annotations.

Lin of Double P
81" =-10.6200781 + 302400782 1 1
: > >

B2" = 30.2400%81 -132 6603782 B

thetat

where

thetal dot2 thetat dot

81 = position of top joint

82 = position of bottom joint
¥ - -18.6200

Gain

-137.3400

F

Gaini

> » 2

thetaZ

thetaZ dot2 thetaZ dot

To use TeX commands in an annotation:
1 Select the annotation.

2 Select Enable TeX Commands from the model editor’s Format menu.
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3 Enter or edit the text of the annotation, using TeX commands where needed
to achieve the desired appearance.

Linearization of Double Pendulum

‘thetat" = -19.6200%thetat + 39 2400™thetaZ
thetaz" = 30 2400™thetat - 132 6603™theta?

where

tthetat = position of top joint
ttheta? = position of bottom joint

See “Mathematical Symbols, Greek Letters, and TeX Characters” in the
MATLAB documentation for information on the TeX formatting commands
supported by Simulink.

4 Deselect the annotation by clicking outside it or typing Esec.

Simulink displays the formatted text.

Linearization of Double Pendulum

81" = -19.6200701 + 30.2400762
B2" = 30.2400%81 -132 6603782

where

81 = position of top joint
82 = position of bottom joint

Creating Annotations Programmatically

You can use the Simulink add_block command to create annotations at the
command line or in an M-file program. Use the following syntax to create the
annotation:

add_block('built-in/Note', 'path/text', 'Position', [center_x, O,
0, center_yl);

where path is the path of the diagram to be annotated, text is the text of the
annotation, and [center_x, 0, 0, center_y] is the position of the center of
the annotation in pixels relative to the upper left corner of the diagram. For
example, the following sequence of commands

new_system('test')
open_system('test')
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add_block('built-in/Gain', 'test/Gain', 'Position', [260, 125,
290, 155])

add_block('built-in/Note', 'test/programmatically created’,
'"Position', [550 0 0 180])

creates the following model:

=10l x|

File Edit WYiew Simulation Format Tools Help

E >
Gain

programmatically created

Ready 100% odeds
4

To delete an annotation, use the find_system command to get the annotation’s
handle. Then use set_param to set the annotation’s Name property to the empty
string, e.g.,
h = find_system('test', 'FindAll', 'on', 'Type', 'annotation');
set_param(h, 'Name', '');
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Creating Subsystems

As your model increases in size and complexity, you can simplify it by grouping
blocks into subsystems. Using subsystems has these advantages:

¢ It helps reduce the number of blocks displayed in your model window.

¢ It allows you to keep functionally related blocks together.

¢ It enables you to establish a hierarchical block diagram, where a Subsystem
block is on one layer and the blocks that make up the subsystem are on
another.

You can create a subsystem in two ways:

® Add a Subsystem block to your model, then open that block and add the
blocks it contains to the subsystem window.

¢ Add the blocks that make up the subsystem, then group those blocks into a
subsystem.

Creating a Subsystem by Adding the Subsystem
Block

To create a subsystem before adding the blocks it contains, add a Subsystem
block to the model, then add the blocks that make up the subsystem:

1 Copy the Subsystem block from the Signals & Systems library into your
model.

2 Open the Subsystem block by double-clicking it.

Simulink opens the subsystem in the current or a new model window,
depending on the model window reuse mode that you selected (see “Window
Reuse” on page 4-24).
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3 In the empty Subsystem window, create the subsystem. Use Inport blocks to

represent input from outside the subsystem and Outport blocks to represent
external output.

For example, the subsystem shown includes a Sum block and Inport and
Outport blocks to represent input to and output from the subsystem.

LT o
2 ) 1 D1ut

In1 Sum

Creating a Subsystem by Grouping Existing Blocks

If your model already contains the blocks you want to convert to a subsystem,
you can create the subsystem by grouping those blocks:

1 Enclose the blocks and connecting lines that you want to include in the
subsystem within a bounding box. You cannot specify the blocks to be
grouped by selecting them individually or by using the Select All command.
For more information, see “Selecting Multiple Objects Using a Bounding
Box” on page 4-3.

For example, this figure shows a model that represents a counter. The Sum
and Unit Delay blocks are selected within a bounding box.

: - simou
Constant | + = v

Sum Unit Crelay ToMfokspace

When you release the mouse button, the two blocks and all the connecting
lines are selected.
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2 Choose Create Subsystem from the Edit menu. Simulink replaces the
selected blocks with a Subsystem block.

This figure shows the model after you choose the Create Subsystem
command (and resize the Subsystem block so the port labels are readable).

Constant To Waotkspace

Subsystem

If you open the Subsystem block, Simulink displays the underlying system, as
shown below. Notice that Simulink adds Inport and Outport blocks to
represent input from and output to blocks outside the subsystem.

1 + 1

Sum Unit Delay butt

As with all blocks, you can change the name of the Subsystem block. You can
also use the masking feature to customize the block’s appearance and dialog
box. See Chapter 12, “Creating Masked Subsystems.”

Undoing Subsystem Creation

To undo creation of a subsystem by grouping blocks, select Undo from the Edit
menu. You can undo creation of a subsystem that you have subsequently
edited. However, the Undo command does not undo any nongraphical changes
that you made to the blocks, such as changing the value of a block parameter
or the name of a block. Simulink alerts you to this limitation by displaying a
warning dialog box before undoing creation of a modified subsystem.
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Model Navigation Commands

Subsystems allow you to create a hierarchical model comprising many layers.
You can navigate this hierarchy, using the Simulink Model Browser (see “The
Model Browser” on page 9-22) and/or the following model navigation
commands:

* Open

The Open command opens the currently selected subsystem. To execute the
command, choose Open from the Simulink Edit menu, press Enter, or
double-click the subsystem.

® Open block in new window

Opens the currently selected subsystem regardless of the Simulink window
reuse settings (see “Window Reuse” on page 4-24).

® Go to Parent

The Go to Parent command displays the parent of the subsystem displayed
in the current window. To execute the command, press Esc or select Go to
Parent from the Simulink View menu.

Window Reuse

You can specify whether Simulink model navigation commands use the current
window or a new window to display a subsystem or its parent. Reusing
windows avoids cluttering your screen with windows. Creating a window for
each subsystem allows you to view subsystems side by side with their parents
or siblings. To specify your preference regarding window reuse, select
Preferences from the Simulink File menu and then select one of the following
Window reuse type options listed in the Simulink Preferences dialog box.

Reuse Open Action Go to Parent (Esc) Action

Type

none Subsystem appears in a new Parent window moves to the
window. front.

reuse Subsystem replaces the Parent window replaces

parent in the current window.  subsystem in current window
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Reuse Open Action Go to Parent (Esc) Action

Type

replace Subsystem appears in a new Parent window appears.
window. Parent window Subsystem window
disappears. disappears.

mixed Subsystem appearsinitsown  Parent window rises to front.
window. Subsystem window

disappears.

Labeling Subsystem Ports

Simulink labels ports on a Subsystem block. The labels are the names of Inport
and Outport blocks that connect the subsystem to blocks outside the subsystem
through these ports.

You can hide (or show) the port labels by

¢ Selecting the Subsystem block, then choosing Hide Port Labels (or Show
Port Labels) from the Format menu

® Selecting an Inport or Outport block in the subsystem and choosing Hide
Name (or Show Name) from the Format menu

¢ Selecting the Show port labels option in the Subsystem block’s parameter
dialog

This figure shows two models. The subsystem on the left contains two Inport
blocks and one Outport block. The Subsystem block on the right shows the
labeled ports.

T+ Int
In1 1 Ot
] +
%}—P ain Qut1 In2
n
Sum Subsystemn
Subsystemn with Inport and Outport blocks Subsystemn with labeled ports
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Controlling Access to Subsystems

Simulink allows you to control user access to subsystems that reside in
libraries. In particular, you can prevent a user from viewing or modifying the
contents of a library subsystem while still allowing the user to employ the
subsystem in a model.

To control access to a library subsystem, open the subsystem’s parameter
dialog box and set its Access parameter to either ReadOnly or NoReadOrWrite.
The first option allows a user to view the contents of the library subsystem and
make local copies but prevents the user from modifying the original library
copy. The second option prevents the user from viewing the contents of,
creating local copies, or modifying the permissions of the library subsystem.
See the Subsystem block for more information on subsystem access options.
Note that both options allow a user to use the library system in models by
creating links (see “Working with Block Libraries” on page 5-32).
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Creating Conditionally Executed Subsystems

A conditionally executed subsystem is a subsystem whose execution depends on
the value of an input signal. The signal that controls whether a subsystem
executes is called the control signal. The signal enters the Subsystem block at
the control input.

Conditionally executed subsystems can be very useful when you are building
complex models that contain components whose execution depends on other
components.

Simulink supports the following types of conditionally executed subsystems:

® An enabled subsystem executes while the control signal is positive. It starts
execution at the time step where the control signal crosses zero (from the
negative to the positive direction) and continues execution while the control
signal remains positive. Enabled subsystems are described in more detail in
“Enabled Subsystems” on page 4-28.

® A triggered subsystem executes once each time a trigger event occurs. A
trigger event can occur on the rising or falling edge of a trigger signal, which
can be continuous or discrete. Triggered subsystems are described in more
detail in “Triggered Subsystems” on page 4-32.

® A triggered and enabled subsystem executes once on the time step when a
trigger event occurs if the enable control signal has a positive value at that
step. See “Triggered and Enabled Subsystems” on page 4-35 for more
information.

e A control flow subsystem executes one or more times at the current time step
when enabled by a control flow block that implements control logic similar to
that expressed by programming language control flow statements (e.g.,
if-then, while, do, and for. See “Modeling with Control Flow Blocks” on
page 4-59 for more information.
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Note Simulink displays an error if you connect a Constant, Model, or
S-Function block with constant sample time (see “Constant Sample Time” on
page 2-37) to the output port of a conditionally executed subsystem. To avoid
the error, either change the sample time of the block to a nonconstant sample
time or insert a Signal Conversion block between the block with constant
sample time and the output port.

Enabled Subsystems

Enabled subsystems are subsystems that execute at each simulation step
where the control signal has a positive value.

An enabled subsystem has a single control input, which can be scalar or vector
valued.

¢ If the input is a scalar, the subsystem executes if the input value is greater
than zero.

e If the input is a vector, the subsystem executes if any of the vector elements
is greater than zero.

For example, if the control input signal is a sine wave, the subsystem is
alternately enabled and disabled, as shown in this figure. An up arrow signifies
enable, a down arrow disable.

Simulink uses the zero-crossing slope method to determine whether an enable
is to occur. If the signal crosses zero and the slope is positive, the subsystem is
enabled. If the slope is negative at the zero crossing, the subsystem is disabled.
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Creating an Enabled Subsystem

You create an enabled subsystem by copying an Enable block from the Signals
& Systems library into a subsystem. Simulink adds an enable symbol and an
enable control input port to the Subsystem block.

Subsystemn

Setting Output Values While the Subsystem Is Disabled. Although an enabled
subsystem does not execute while it is disabled, the output signal is still
available to other blocks. While an enabled subsystem is disabled, you can
choose to hold the subsystem outputs at their previous values or reset them to
their initial conditions.

Open each Outport block’s dialog box and select one of the choices for the
Output when disabled parameter, as shown in the following dialog box:
® Choose held to cause the output to maintain its most recent value.

¢ Choose reset to cause the output to revert to its initial condition. Set the
Initial output to the initial value of the output.

Block Parameters: Outl

— Outport

Provide an output port for a subsystem or model. The 'Dutput when
dizabled' and 'Initial output' parameters only apply to conditionally executed
subgpstems. When a conditionally executed subsystem iz disabled, the
output iz either held at itz last value or zet ta the 'Initial output’. The Initial
output' parameter can be specified as the empty matrix, []. in which caze
the initial output is equal to the output of the block feeding the outport.

Part number:
f1 Select an option fo set the Outport output while the

held &~ subsystem is disabled.

Output when dizabled:

Initial output:

<

QK I Cancel | Help | Apply |

The initial condition and the value when reset.

Setting States When the Subsystem Becomes Reenabled. When an enabled subsystem
executes, you can choose whether to hold the subsystem states at their previous
values or reset them to their initial conditions.
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To do this, open the Enable block dialog box and select one of the choices for the
States when enabling parameter, as shown in the dialog box following:

® Choose held to cause the states to maintain their most recent values.

® Choose reset to cause the states to revert to their initial conditions.

Block Parameters: Enable

" Enable Part

Flace thiz block in a subsystem to create an enabled subspstem. ‘

=
F

5 h bling: |held -
S AR CRELAE "ﬁ .............................................................. Seled an option to set 'he states when Ihe SUbSYS'em is

™ Show output port
reenabled.

QK I Cancel | Help | Lppli |

Outputting the Enable Control Signal. An option on the Enable block dialog box lets
you output the enable control signal. To output the control signal, select the
Show output port check box.

Block Parameters: Enable

" Enable Part

Flace thiz block in a subsystem to create an enabled subspstem. ‘

=
F

States wh

bling: I held j

rk

QK I Cancel | Help | Apply |

This feature allows you to pass the control signal down into the enabled
subsystem, which can be useful where logic within the enabled subsystem is
dependent on the value or values contained in the control signal.

Blocks an Enabled Subsystem Can Contain

An enabled subsystem can contain any block, whether continuous or discrete.
Discrete blocks in an enabled subsystem execute only when the subsystem
executes, and only when their sample times are synchronized with the

simulation sample time. Enabled subsystems and the model use a common
clock.



Creating Conditionally Executed Subsystems

Note Enabled subsystems can contain Goto blocks. However, only state ports
can connect to Goto blocks in an enabled subsystem. See the Simulink demo
model, clutch, for an example of how to use Goto blocks in an enabled
subsystem.

For example, this system contains four discrete blocks and a control signal. The
discrete blocks are

¢ Block A, which has a sample time of 0.25 second

¢ Block B, which has a sample time of 0.5 second

¢ Block C, within the enabled subsystem, which has a sample time of 0.125
second

¢ Block D, also within the enabled subsystem, which has a sample time of 0.25
second

The enable control signal is generated by a Pulse Generator block, labeled
Signal E, which changes from 0 to 1 at 0.375 second and returns to 0 at 0.875
second.

ﬂ_ﬂﬂ Signal E

1 Enable
=
Sine Wrave Blod A Dizplay (T_)_h ; _@
_ In1 Outq
Ts=025 block C
Ts=0.125
! L]
W pe{inz  Out2 - ;
= (2w - (2
Random Block B Soope Inz z e
Number T==0.45 Subsysterm’ T~ - - _ blodk D
To- Ts=025
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The chart below indicates when the discrete blocks execute.

| | | I I I |
1

- ==+ — I l : —|— -
Signal E | 0 | JE U I R I I
Block D | | _ A _| A_ | | A - Start of execution

______ R T, T for a block
Block C __|_|__A_A_A_J_|__|__ rae
Block B _l_ l_ _ | | |

|
o | | | j‘ |
o ——=T =T 1— 11— -

Time (sec)

Blocks A and B execute independently of the enable control signal because they
are not part of the enabled subsystem. When the enable control signal becomes
positive, blocks C and D execute at their assigned sample rates until the enable
control signal becomes zero again. Note that block C does not execute at 0.875
second when the enable control signal changes to zero.

Triggered Subsystems

Triggered subsystems are subsystems that execute each time a trigger event
occurs.

A triggered subsystem has a single control input, called the trigger input, that
determines whether the subsystem executes. You can choose from three types
of trigger events to force a triggered subsystem to begin execution:

® rising triggers execution of the subsystem when the control signal rises
from a negative or zero value to a positive value (or zero if the initial value
is negative).

e falling triggers execution of the subsystem when the control signal falls
from a positive or a zero value to a negative value (or zero if the initial value
is positive).

® either triggers execution of the subsystem when the signal is either rising
or falling.
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Note In the case of discrete systems, a signal’s rising or falling from zero is
considered a trigger event only if the signal has remained at zero for more
than one time step preceding the rise or fall. This eliminates false triggers
caused by control signal sampling.

For example, in the following timing diagram for a discrete system, a rising
trigger (R) does not occur at time step 3 because the signal has remained at zero
for only one time step when the rise occurs.

0 4 p Time

Signal Level

A simple example of a triggered subsystem is illustrated.

ﬂ_ﬂ_ﬂ_ Trigger
Signal

vy .-
F : Trigger
B—bln Ot | simout 3
i C—w = w1
Sine Wawve o Ta Wakspace i z ot
Subsystem Tte- - Unit Delay

In this example, the subsystem is triggered on the rising edge of the square
wave trigger control signal.
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Creating a Triggered Subsystem

You create a triggered subsystem by copying the Trigger block from the Signals
& Systems library into a subsystem. Simulink adds a trigger symbol and a
trigger control input port to the Subsystem block.

A+

Subsystem

To select the trigger type, open the Trigger block dialog box and select one of
the choices for the Trigger type parameter, as shown in the following dialog
box:

Block Parameters: Trigger K|

— Trigger Port

Flace thiz block in a subsystem to create a triggered subsystem.

=

<« Select the trigger type.

Trigger type: ([T

States when enabling: Iheld -

[~ Show output port

Dutput data ype: Iauto j

[¥ Enable zero crossing detection

QK I Cancel | Help | Apply |

Simulink uses different symbols on the Trigger and Subsystem blocks to
indicate rising and falling triggers (or either). This figure shows the trigger
symbols on Subsystem blocks.

E3 T EXS
Subsystem with Subsystem with Subsystem with
Rizing trigger Falling trigger Rizing ar Falling
trigger

Outputs and States Between Trigger Events. Unlike enabled subsystems, triggered
subsystems always hold their outputs at the last value between triggering
events. Also, triggered subsystems cannot reset their states when triggered;
states of any discrete blocks are held between trigger events.
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Outputting the Trigger Control Signal. An option on the Trigger block dialog box lets
you output the trigger control signal. To output the control signal, select the
Show output port check box.

Block Parameters: Trigger: E #

— Trigger Port

Flace thiz block in a subsystem to create a triggered subsystem.

=

Trigger type: ([T

States when enabling: Iheld -
[~ Show output port. < Select this check box to show the output port.
[Output data type; Iauto j

[¥ Enable zero crossing detection

QK I Cancel | Help | Apply |

The Output data type field allows you to specify the data type of the output
signal as auto, int8, or double. The auto option causes the data type of the

output signal to be set to the data type (either int8 or double) of the port to
which the signal is connected.

Function-Call Subsystems

You can use a Trigger block to create a subsystem whose execution is
determined by logic internal to an S-function instead of by the value of a signal.
These subsystems are called function-call subsystems. For more information
about function-call subsystems, see “Function-Call Subsystems” in the Writing
S-Functions documentation.

Blocks That a Triggered Subsystem Can Contain

All blocks in a triggered systems must have either inherited (-1) or constant
(inf) sample time. This is to indicate that the blocks in the triggered subsystem
run only when the triggered subsystem itself runs, i.e., when it is triggered.
This requirement means that a triggered subsystem cannot contain continuous
blocks, such as the Integrator block.

Triggered and Enabled Subsystems

A third kind of conditionally executed subsystem combines both types of
conditional execution. The behavior of this type of subsystem, called a triggered
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and enabled subsystem, is a combination of the enabled subsystem and the
triggered subsystem, as shown by this flow diagram.

Trigger event

Is

input signal Don't execute the subsystem

>07?

Execute the subsystem

A triggered and enabled subsystem contains both an enable input port and a
trigger input port. When the trigger event occurs, Simulink checks the enable
input port to evaluate the enable control signal. Ifits value is greater than zero,
Simulink executes the subsystem. If both inputs are vectors, the subsystem
executes if at least one element of each vector is nonzero.

The subsystem executes once at the time step at which the trigger event occurs.

Creating a Triggered and Enabled Subsystem

You create a triggered and enabled subsystem by dragging both the Enable and
Trigger blocks from the Signals & Systems library into an existing subsystem.
Simulink adds enable and trigger symbols and enable and trigger and enable
control inputs to the Subsystem block.

n £

Subsystem

You can set output values when a triggered and enabled subsystem is disabled
as you would for an enabled subsystem. For more information, see “Setting
Output Values While the Subsystem Is Disabled” on page 4-29. Also, you can
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specify what the values of the states are when the subsystem is reenabled. See
“Setting States When the Subsystem Becomes Reenabled” on page 4-29.

Set the parameters for the Enable and Trigger blocks separately. The
procedures are the same as those described for the individual blocks.

A Sample Triggered and Enabled Subsystem
A simple example of a triggered and enabled subsystem is illustrated in the
model below.

Enable

Trigger
Signal iy

Signal

ST

Sine Wave Drizplay

* Subsystem

Enakble Trigger

1
In = Out
Unit Delay

Creating Alternately Executing Subsystems

You can use conditionally executed subsystems in combination with Merge
blocks to create sets of subsystems that execute alternately, depending on the
current state of the model. For example, the following figure shows a model
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that uses two enabled blocks and a Merge block to model a full-wave rectifier,
that is, a device that converts AC current to pulsating DC current.
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In this example, the block labeled “pos” is enabled when the AC waveform is
positive; it passes the waveform unchanged to its output. The block labeled
“neg” is enabled when the waveform is negative; it inverts the waveform. The
Merge block passes the output of the currently enabled block to the Mux block,
which passes the output